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Introduction 
MAGic User’s Guide 

About This Book 
The MAGic User’s Guide teaches you to use and customize MAGic’s 
magnification and speech capabilities to fit your personal needs. In the 
front of the book, you can find perforated keystroke reference cards that 
contain a list of important MAGic commands. Chapter 1 Quick Start 
Guide gives you the basics to get up and running with MAGic. Chapter 2 
Navigating MAGic explains how to use your keyboard and mouse with 
MAGic. Chapter 3 User Interface provides details on the buttons and 
other options available on the MAGic user interface. Chapter 4 
Magnification describes how to customize MAGic’s magnification 
features, including mouse, cursor, and color enhancements. Chapter 5 
Speech explains how you can customize how MAGic uses synthesized 
speech to read text on your screen. Chapter 6 Keyboard provides 
information on customizing MAGic’s keystrokes. Chapter 7 Application 
Specific Functions describes MAGic commands you can use in Microsoft 
Word, Excel, and Internet Explorer.  Chapter 8 Contacting Freedom 
Scientific tells you how to find our Web site and contact technical 
support. 

Items Checklist 
In your MAGic package, you should find the following items. If you 
discover damaged or missing items, please contact your retailer. 

• CD wallet containing one program CD-ROM and either an 
authorization or update disk 

• Registration disk and return mail envelope 

• MAGic User’s Guide 
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Chapter 1 
Quick Start Guide 

Welcome to MAGic 
MAGic is a software solution ideally suited for computer users with low 
vision, or anyone who spends extended periods of time in front of a 
computer screen.  

MAGic lets you magnify your computer screen from 1 to 16 times its 
usual size. You can choose from a number of different adjustable views 
that let you see both a magnified and unmagnified portion of the screen 
at the same time.  

Speech features assist you in processing the information on your screen. 
MAGic can read text that you type or point at with the mouse. MAGic 
moves the magnified area of the screen so you always see the text 
being read and highlights words as they are spoken.  

Mouse and cursor enhancements help you track the location of the 
mouse pointer and cursor on the screen. You can choose from a wide 
variety of enhancement styles. MAGic lets you change the color of these 
enhancements, apply transparency effects, adjust their size, and more.  

Color enhancements let you change how colors display on your screen. 
You can create rules that replace one color with another or switch two 
colors. You can also apply color tinting, make your screen black-and-
white (monochrome), and invert the brightness and colors of your 
display. 

Other MAGic features track elements of your screen, such as the mouse 
pointer, dialog boxes, and so on. The Locator feature provides you with a 
way to quickly find and move to different areas of the screen. The MAGic 
multi-directional panning system gives you complete control with 
adjustable speed, direction, stop and start, and screen navigation 
controls. 
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System Requirements 
The recommended system requirements for MAGic are listed below.  

Specification Minimum Requirement 

MAGic Standard Windows 95/98/ME/2000/XP Home* 

MAGic Professional Windows 95/98/ME/NT/2000/XP Home 
and Pro* 

Processor speed 166 MHz 

RAM 64 MB 

Available hard disk space 
for installation 

75 MB 

Available hard disk space 
after installation 

45 MB 

Video 256 color graphics** 

Sound Windows compatible sound card (for 
speech option) 

* Some MAGic features are not available for Windows 95/98/ME users.  

** While MAGic will work with 256 colors, it is recommended that you 
use high or true color depth (16-bit color or higher). 

Installing MAGic 
1. Insert the MAGic CD into your CD-ROM drive. 

2. The MAGic Setup program starts. You will hear the installation 
speak the instructions as they appear on your screen. Follow these 
instructions to complete the MAGic installation. 

If your MAGic installation CD does not start automatically, click the Start 
button, select Run, and type D:\setup. If your CD-ROM is not D, 
substitute the correct drive letter. 
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The MAGic setup program will then begin. 

Choose to run the automatic or guided installation of MAGic. The 
automatic installation assumes that you want to install all languages 
and you approve of the default location where MAGic is stored on your 
hard disk. Use the guided installation if you want to specify which 
languages to install, where MAGic is stored on your computer, or 
whether MAGic should start automatically when you start Windows.   

Instructions for installing MAGic on a network can be found in the online 
help system. 

Product Activation  
After you install MAGic, you must activate your software. MAGic runs in 
40 minute mode until it is activated on your computer. Internet License 
Manager (ILM) allows you to quickly activate MAGic using the Internet. 
If you do not have an Internet connection, you can activate MAGic by 
telephone or fax. Alternatively, you can activate MAGic with the 
assistance of a trusted friend, relative, or organization that has access 
to the Internet.  

Tip:  For information on activating a multi-user network license of 
MAGic, refer to the Network MAGic book in the MAGic online 
help. 

If you purchased a single-user license of MAGic, you are asked to 
activate when you first start the program. You can activate MAGic at a 
later time by opening the Help menu and choosing Update 
Authorization. Choose one of the following activation methods and refer 
to the listed page for detailed instructions: 

• Activate using the Internet (page 5) 

• Activate by Telephone (page 7) 

• Activate by Fax (page 8) 

• Activate with the Help of a Trusted Third Party (page 10) 
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Note:  If you are using Windows 2000, XP, or NT, your user account 
must have power user or administrator privileges to activate 
MAGic. Contact your network administrator if your account 
does not have the required level of access. 

You can also use a dongle (a hardware device that connects to your 
computer's USB or parallel port) to make your MAGic license more 
portable. A dongle allows you to use an authorized version of MAGic on 
any computer as long as the dongle remains connected. For more 
information, see Dongle Authorization on page 12. 

If your version of MAGic does not use Internet License Manager 
authorization, refer to page 13 for information on 3.5-inch Disk (Quella) 
Authorization. 

Activating with Internet License Manager 
You can use Internet License Manager (ILM) to activate MAGic using an 
Internet connection. This is the easiest and quickest way to activate 
your product.  

When you first start MAGic, you are asked to activate the program. You 
can also begin the activation process by opening the Help menu and 
choosing Update Authorization. To activate MAGic using the Internet, do 
the following: 

1. In the Activation dialog box, choose Start Activation.  

2. Read the message that displays and then choose Continue. Insert 
the Authorization CD into your CD-ROM drive and choose Activate 
Using Authorization CD. You can find your Authorization CD in the 
same sleeve as your MAGic program CD. If you do not have your 
Authorization CD, choose Enter Your Authorization Number 
Manually.  

Note:  If you have previously inserted your Authorization CD, you 
will not be asked to insert it again. Continue to step 3 of the 
activation. 

3. Choose Activate.  
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4. Use the arrow keys to select Now, Using the Internet 
(RECOMMENDED), and then press ENTER.  

5. If you used your Authorization CD, your 20-digit Authorization 
number is automatically inserted into the Authorization Number 
edit box. If your Authorization number is not shown, type it into 
the edit box. You can find your Authorization number in print and 
Braille on your MAGic CD sleeve.  

6. Press ENTER to continue. You will be asked to connect to the 
Internet if you have not already done so. You must establish an 
Internet connection before continuing with the activation.  

7. If you have not registered MAGic, you are asked to do so now. 
Registering MAGic lets you receive technical support. Choose 
Register Now and complete the online registration form by 
following the instructions provided. You can choose to register 
later, but you must register the next time you activate MAGic.  

8. After you submit your registration, Internet License Manager 
attempts to activate MAGic. This process may take several 
minutes. When the activation is successful, choose Finish.  

Note:  If Internet License Manager cannot activate MAGic because of 
your firewall software, see Troubleshooting Firewall Software 
on page 6. 

Troubleshooting Firewall Software 

Firewalls protect computer systems from being accessed by 
unauthorized users. Some network or personal firewall software may 
interfere with the installation, activation, or usage of MAGic. The 
following information will help you reconfigure your firewall to work 
with MAGic. Refer to your firewall software documentation for more 
information on allowing access for programs and files. 

Note:  Hardware firewalls do not interfere with installing, activating, 
or running MAGic. 
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Firewall Interferes with Installation 

If your firewall software is preventing you from installing MAGic on your 
computer, reconfigure the firewall to allow the file Setup.exe to run. 
Then retry the installation procedure. 

Firewall Interferes with Activation 

If your firewall software prevents you from activating MAGic using the 
Internet, reconfigure the firewall to allow the following files to run: 
FSActivate.exe, CAUtil.exe, and CAUtil.enu. Once you have reconfigured 
your firewall, retry the activation process. If you cannot reconfigure the 
firewall, or if you still cannot activate MAGic, go to www.FSActivate.com. 
Follow the instructions on the Web page to retrieve an Activation 
License code and activate your software. For more information on using 
www.FSActivate.com, see Activating through a Trusted Third Party on 
page 10. 

Firewall Interferes with Using MAGic 

If the firewall software prevents MAGic from running or starting, or 
displays a warning message, reconfigure the firewall to allow the file 
JFW.exe to run.  

Advanced Troubleshooting Information 

For a complete list of all files that need to be allowed by your firewall 
software, including the connection type, incoming port, and outgoing 
port, refer to Advanced Troubleshooting in the MAGic Online Help.  

Activating by Telephone 
If you do not have an Internet connection, you can call Freedom 
Scientific Customer Service. Customer Service will send you a CD in the 
mail that will automatically activate MAGic.  

When you first start MAGic, you are asked to activate the program. You 
can also begin the activation process by opening the Help menu and 
choosing Update Authorization. To activate MAGic by telephone, do the 
following: 

1. In the Activation dialog box, choose Start Activation.  
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2. Read the message that displays and then choose Continue. Insert 
the Authorization CD into your CD-ROM drive and choose Activate 
Using Authorization CD. You can find your Authorization CD in the 
same sleeve as your MAGic program CD. If you do not have your 
Authorization CD, choose Enter Your Authorization Number 
Manually.  

Note:  If you have previously inserted your Authorization CD, you 
will not be asked to insert it again. Continue to step 3 of the 
activation. 

3. Choose Activate.  

4. Use the arrow keys to select Telephone to Receive Activation by 
Mail, and then press ENTER.  

5. Call (727) 803-8015. Provide the customer service representative 
with the Authorization number and Locking code shown in this 
dialog box. If your Authorization number is not shown, you can 
find it in print and Braille on your MAGic CD sleeve.  

6. Choose Quit. You can continue using MAGic in 40 minute mode 
until you receive your CD.  

When you receive the CD with your Activation License code from 
Freedom Scientific, insert it into your CD-ROM drive to automatically 
activate MAGic.  

Note:  If the CD does not automatically activate your software, press 
WINDOWS Key+R, type "D:\ActivationCode.exe" and press 
ENTER. If your CD-ROM drive is not D:, then substitute the 
correct letter.  

Activating by Fax 
If you do not have an Internet connection, you can send a fax to 
Freedom Scientific with your Authorization number and Locking code. 
You will then receive an Activation License code either in an e-mail 
message or on a CD.  
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When you first start JAWS, you are asked to activate the program. You 
can also begin the activation process by opening the Help menu and 
choosing Update Authorization. To activate JAWS by fax, do the 
following: 

1. In the Activation dialog box, choose Start Activation.  

2. Read the message that displays and then choose Continue. Insert 
the Authorization CD into your CD-ROM drive and choose Activate 
Using Authorization CD. You can find your Authorization CD in the 
same sleeve as your JAWS program CD. If you do not have your 
Authorization CD, choose Enter Your Authorization Number 
Manually.  

Note:  If you have previously inserted your Authorization CD, you 
will not be asked to insert it again. Continue to step 3 of the 
activation. 

3. Choose Activate.  

4. Use the arrow keys to select Fax, and then press ENTER.  

5. Complete the form by typing the required information into the edit 
boxes. If you want to receive your Activation License code in an e-
mail message, enter your e-mail address. If you do not enter an e-
mail address, Freedom Scientific will send you a CD in the mail 
that will automatically activate JAWS.  

6. If you used your Authorization CD, your 20-digit Authorization 
number is automatically inserted into the Authorization Number 
edit box. If your Authorization number is not shown, type it into 
the edit box. You can find your Authorization number in print and 
Braille on your JAWS CD sleeve.  

7. Choose Print to send the form to your printer. After you have 
printed the form, choose Quit.  

8. Fax the printed form to (727) 803-8001.  
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If you entered your e-mail address, you should receive an e-mail 
message from Freedom Scientific within one or two business days. 
Follow the instructions provided in the message to activate JAWS. If you 
do not enter an e-mail address, you will receive a CD from Freedom 
Scientific in the mail. Insert the CD into your CD-ROM drive to 
automatically activate JAWS. 

Note:  If the CD does not automatically activate your software, press 
WINDOWS Key+R, type "D:\ActivationCode.exe" and press 
ENTER. If your CD-ROM drive is not D:, then substitute the 
correct letter.  

Activating through a Trusted Third Party 
If you know a friend, relative, or other trusted person with an Internet 
connection, they can help you activate MAGic. Alternatively, you can use 
an Internet connection in a library, at work, or anywhere else. You or a 
trusted third party can visit www.FSActivate.com to obtain your 
Activation License code.  

Tip:  A free program from Freedom Scientific called Activation 
Media Image Creator lets you create a CD, 3.5-inch disk, or e-
mail attachment containing MAGic license information.  

To obtain an Activation License code from FSActivate.com, do the 
following: 

1. Point your Web browser to http://www.FSActivate.com.  

2. Enter your 20-digit Authorization number and Locking code. Your 
Authorization number appears on your MAGic CD sleeve in both 
print and Braille. To find your computer's Locking code, open the 
MAGic Help menu and choose About.  

Note:  The Locking code is unique for each individual computer. Be 
sure you enter the Locking code of the computer you intend 
to use with MAGic when it is activated. 

3. Choose Submit License Request to receive an Activation License 
code.  
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4. The remaining steps must be completed on the computer where 
the copy of MAGic you want to activate is installed. Begin by 
starting MAGic on this computer. From the MAGic Help menu, 
choose Update Authorization.  

5. In the Activation dialog box, choose Start Activation.  

6. Read the message that displays and then choose Continue. Insert 
the Authorization CD into your CD-ROM drive and choose Activate 
Using Authorization CD. You can find your Authorization CD in the 
same sleeve as your MAGic program CD. If you do not have your 
Authorization CD, choose Enter Your Authorization Number 
Manually.  

Note:  If you have previously inserted your Authorization CD, you 
will not be asked to insert it again. Continue to step 7 of the 
activation. 

7. Choose Activate.  

8. Use the arrow keys to select the Activation Generated from 
www.FSActivate.com radio button and press ENTER.  

9. Type the Activation License code you received from 
www.FSActivate.com into the edit box and then press ENTER.  

10. After you have successfully activated MAGic, choose Finish to 
complete the process.  

Using Activation Media Image Creator 

Activation Media Image Creator is a free program from Freedom 
Scientific that allows a user with an Internet connection to retrieve 
Activation License codes from Internet License Manager. The user can 
then distribute these Activation License codes on CD, 3.5-inch disk, or 
e-mail. Users without Internet connections can use the files created by 
this program to activate MAGic without having to type the lengthy 
Activation License code.  



 

12 

To download the installation package for Activation Media Image 
Creator, visit www.FSActivate.com. After you install the program, follow 
the instructions in the Activation Media Image Creator online Help to 
retrieve and distribute Activation License codes from Internet License 
Manager. 

Dongle Authorization 
A dongle is a hardware device that you can connect to a computer's 
parallel or USB port (depending on the type of dongle). MAGic is 
authorized to run on that computer as long as the dongle remains 
connected. This is useful if you frequently need to use MAGic on many 
different computers and do not want to activate the program on each of 
them.  

When MAGic starts, it first determines whether a dongle is connected to 
the computer. If one is connected, MAGic uses the features and 
information for the license associated with the dongle to authorize 
MAGic. If no dongle is connected, MAGic searches for the license 
information stored on the computer. You can use the Dongle Viewer 
utility to view information on the license associated with the dongle 
currently connected to your computer. To start this utility, go to the 
MAGic program group, open the Tools submenu, and choose Dongle 
Viewer. 

Note:  It is recommended that you do not connect the dongle to 
your computer until after you install MAGic. If the dongle was 
connected before or during installation, you must restart your 
computer to receive proper authorization. 

Dongles are sold separately or as an additional MAGic feature. Contact 
Freedom Scientific Sales if you want to purchase one.  

Note:  Certain international versions of MAGic require a dongle for 
authorization. Using one of these versions without a dongle 
displays an error message. 
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3.5-inch Disk (Quella) Authorization 
If your version of MAGic uses a 3.5-inch disk for authorization instead of 
Internet License Manager, this section will help you authorize your 
software.  

The authorization key contains the information your computer needs to 
run MAGic. MAGic prompts you for either an authorization disk or an 
update disk, if you received one. Follow the instructions that appear on 
the screen to complete your authorization of MAGic. The first time you 
start MAGic, you are asked to register your software. 

Uninstalling MAGic  
To uninstall MAGic go to the Program menu and select the Uninstall 
MAGic option in the MAGic submenu. 

MAGic Program Group 
To see the MAGic program group, click the Start button and choose 
Programs, MAGic. The contents of the MAGic program group display in 
the MAGic submenu.  

 

Within the MAGic program group, you will find the following: 

• FSReader Demo - Starts FSReader Demo. This program allows you 
to listen to DAISY books created by Freedom Scientific. The MAGic 
Basic Training is available in DAISY format. You can install this 
book when you install MAGic. After you start FSReader, open the 
File menu and choose Open. You can listen to the included 
"FSReaderGettingStarted" DAISY book to learn how to use the 
program. 

• Help – Opens the online help system. 



 

14 

• MAGic – Launches the MAGic program. 

• View Readme.txt – The MAGic Readme.txt contains important 
information regarding installing and uninstalling MAGic, starting 
MAGic, technical notes and known issues, video card compatibility, 
and contact information for Freedom Scientific. 

Tools Folder 
This folder contains the following MAGic utilities: 

• Dongle Viewer – Allows you to view license information for the 
dongle currently connected to your computer. For more 
information on using a dongle to authorize MAGic, refer to Dongle 
Authorization on page 12. 

• Installation Maintenance – Allows you to modify, repair, or remove 
MAGic. Use the Modify option to change the languages that you 
have installed with MAGic. This is also a useful setting for 
troubleshooting. Use the Repair option to reinstall MAGic. Use the 
Remove option to uninstall MAGic from your system. 

• MAGic Network Administrator - Network administrators use this to 
add, delete, and modify user settings of MAGic in a network 
environment. 

• Uninstall MAGic – Used to uninstall MAGic from your computer. 

• Video Intercept - Allows you to install/uninstall Video Intercept 
and displays information about your computer’s display adapter, 
video chain, and Display Chaining Manager (DCM) compliant 
drivers. 

• ILM Authorization Viewer - Allows you to view details of your ILM 
software licenses. 

• Remove Product Activation - Allows you to delete your ILM 
licenses for all versions of MAGic installed on this computer. Until 
you acquire a new license, you will only be able to use MAGic in 40 
minute mode.  
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Explore MAGic 
This folder provides shortcuts to folders containing your user settings, 
shared settings, and program files. 

• Explore My Settings - Opens the folder containing your user-
specific MAGic settings. When you create new schemes or modify 
factory schemes, MAGic saves them in this folder. Your custom 
settings are also saved in this folder. 

• Explore Program Files - Opens the folder where you installed 
MAGic, allowing you to access the program files. 

• Explore Shared Settings - Opens the folder containing your shared 
MAGic settings. Factory schemes and default factory settings are 
saved in this folder. 

Starting MAGic 
MAGic gives you a variety of ways to start the program.  

• Press the hot key, ALT+CTRL+M, which is automatically assigned 
when you install MAGic.  

• Double-click the MAGic icon on your desktop.  

• From the Start menu, choose Programs, open the MAGic submenu, 
and choose MAGic. 

After you start MAGic for the first time, you can choose to run the 
program when Windows starts. To do this, open the File menu, choose 
Preferences, and select the Run MAGic at Startup check box. 

Quitting MAGic  
To quit MAGic, do one of the following: 

• Press ALT+F4  

• Click the  in the top right hand corner of the window.  

• Select Exit from the File menu.  
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Tip:  If you want MAGic to ask you to save your settings when you 
quit, open the File menu and choose Preferences. Select the 
Prompt to Save Settings on Exit check box. 

Overview of MAGic for New Users 
Start MAGic by pressing ALT+CTRL+M or by double-clicking the MAGic 
program icon on your Windows desktop. You can also start MAGic by 
opening the Start menu, choosing Programs, MAGic and then selecting 
MAGic. 

When you first start MAGic, your screen is displayed in 2× magnification 
using the Full view. Speech will also be enabled. You can change the 
magnification level, magnified view, speech, and many other options by 
using the MAGic user interface. 

The user interface is a small window that allows you to control all 
aspects of MAGic. This window contains the magnification and speech 
buttons in addition to the MAGic menu and title bars. The user interface 
is shown below. 

For more information on the MAGic user interface, please refer to 
Chapter 3 User Interface. 
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Magnification and Speech Buttons 
One of the first things you will notice about the user interface are the 
rows of blue and orange buttons. The blue buttons control magnification 
features while the orange buttons control speech. Below are brief 
descriptions of each button.  

Button Function 

 

Use the Magnification button to enable or disable 
magnification. 

 

The current magnification level can be adjusted with 
the two Magnification Level buttons. The number in the 
box shows the current magnification level.  

 
Use the Mouse Enhancements button to enable/disable 
enhancements and modifications for your mouse 
pointer. These enhancements make the mouse pointer 
easier to track and maneuver on your screen. 
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Button Function 

 
Use the Cursor Enhancements button to enable/disable 
enhancements for your cursor. These enhancements 
make the cursor easier to follow when editing or 
writing text. 

 
Use the Color Enhancements button to enable/disable 
color enhancements. This feature allows you to replace 
colors, adjust the brightness and contrast, apply 
tinting, and invert the brightness and colors of your 
display.  

 
Use the Locator button to enable/disable the Locator 
function. The Locator function allows you to find items 
on your screen.  

 
Use the Smoothing button to enable/disable 
smoothing. This feature smoothes the appearance of 
jagged letters in a magnified state.  

 
The Resize View button allows you to change the 
dimensions of your magnified view. 

 
Select your preferred magnified view from the 
Magnified Views list. 

 
Use the Speech button to enable or disable speech. 

 
Use the Mouse Echo button to toggle the mouse echo 
feature on and off. Mouse echo enables MAGic to read 
text that you point at with the mouse.  

  
Use the Typing Echo button to enable or disable typing 
echo. If typing echo is enabled, MAGic announces the 
words or characters you type.  
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MAGic Menus 
Located above these buttons is the menu bar. The menu bar allows you 
to customize speech, magnification, and your keyboard. You can also 
view help information and perform other functions. Each menu is 
described below.  

 

Menu Purpose 

File The File menu allows you to save your settings and 
restore the original Freedom Scientific settings. You can 
also use this menu to change your MAGic preferences. 

Magnification The Magnification menu allows you to customize how 
you view your screen with MAGic. You can also change 
mouse options, panning settings, view properties, and 
more. 

Speech You can customize MAGic’s speech components to fit 
your particular needs. The Speech menu allows you to 
customize how you read text with MAGic. 

Keyboard The Keyboard menu allows you to customize how you 
use your PC's keyboard with MAGic. You can re-assign 
the MAGic Key to a different key or manage shortcut 
keys. 

Help The Help menu provides you with detailed help 
information for the various MAGic functions and 
options. You can also view information on the newest 
features for this release and see your current MAGic 
version. 
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Most of these commands display a dialog box that allows you to 
customize certain aspects of MAGic. You can press F1 or use the  
button to get help on any option in the dialog box. From the MAGic user 
interface, you can select Help Topics from the Help menu to view the 
complete online help system which provides a full-text search, index, 
and table of contents to help you find the information you need. For 
more information on MAGic Help, refer to Getting Help on page 24. 

The MAGic Key 
The MAGic Key is the CAPS LOCK key on your keyboard. Pressing the 
MAGic Key in combination with other keys activates a number of MAGic 
commands. If you want to assign the MAGic Key to a different key on 
your keyboard, open the Keyboard menu and choose MAGic Key. For 
more information, refer to MAGic Key on page 86. 

Hot Keys 
In addition to the menus and magnification/speech buttons, there are a 
number of keyboard hot keys you can use at any time to read text, 
change how MAGic magnifies your screen, or perform a variety of other 
functions. For a complete list of hot keys, refer to Appendix C MAGic Hot 
Keys on page 101.  

Reading Text with MAGic 
MAGic can use synthesized speech to read text that appears on your 
screen, including documents, menus, dialog boxes, e-mail messages, 
Web pages, and more. Additionally, MAGic can highlight the text as it is 
spoken. To customize MAGic’s speech, use the commands available on 
the Speech menu. 

Tip:  You can silence MAGic’s speech at any time by pressing CTRL. 
To toggle speech on or off, press MAGic Key+F3. 
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Using the Mouse to Read Text 
Mouse echo is a feature that allows you to read text with your mouse. 
To use mouse echo, just move your mouse pointer to some text on your 
screen and then stop. After a short delay, MAGic will speak the word you 
pointed to. You can use the Mouse Echo button to enable or disable this 
feature. For more information, refer to Mouse Echo on page 76. 

Using the Keyboard to Read Text 
MAGic has a number of different keystrokes that let you use the 
keyboard to read text. To use these keystrokes, move your insertion 
point or mouse pointer to any location within the document. Then press 
one of the following key combinations to read from that location: 

• To begin reading from your current location, press MAGic 
Key+SPACEBAR or INSERT+DOWN ARROW. 

• To read the current word, press MAGic Key+ALT or INSERT+NUM 
PAD 5. To spell the current word, press the keystroke twice 
quickly. 

• To read the next word, press INSERT+RIGHT ARROW. To read the 
previous word, press INSERT+LEFT ARROW. 

• To read the current line, press MAGic Key+L or INSERT+UP 
ARROW. To read from the beginning of the line to the current 
position of the cursor, press INSERT+HOME. To read from the 
current position of the cursor to the end of the line, press 
INSERT+PAGE UP. 

• To read the current sentence, press MAGic Key+S. To read the next 
sentence, press MAGic Key+SHIFT+S. 

• To read the current paragraph, press MAGic Key+P. 

• To begin reading a column of text from your current location, press 
MAGic Key+C. 

• To read the current color block, press MAGic Key+CTRL. MAGic 
reads any connected words with the same foreground and 
background colors. You can use this command to read text that 
you have selected. 
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• To hear the contents of the Clipboard, press MAGic Key+X. 

Note:  By default, the MAGic Key is assigned to the CAPS LOCK key. 
To change this, open the Keyboard menu and choose MAGic 
Key. Refer to MAGic Key on page 86 for more information. 

When you read text with these keystrokes, MAGic highlights the word it 
is currently speaking. To change the color and/or style of this 
highlighting, open the Speech menu and choose Document and Text 
Reading. For more details, see Document and Text Reading on page 83. 

Typing Echo 
If typing echo is enabled, MAGic repeats each character or word that you 
type. MAGic also speaks the character to the right of the insertion point 
when you use the arrow keys to move through text. You can use the 
Typing Echo button to enable or disable this feature. For more 
information, refer to Typing Echo on page 77. 

Changing your Preferences 
From the File menu, choose Preferences to change the way you use 
MAGic on your computer. You can use this dialog box to start MAGic 
when your computer starts, disable your screen saver while MAGic is 
running, minimize MAGic when it starts, enable/disable the bilingual 
user interface, specify whether MAGic should prompt you before 
overwriting schemes, and determine whether MAGic asks you to save 
your settings when you quit. After you close this dialog box, you must 
choose Save Settings from the File menu to save any changes you made 
to your preferences. 
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Minimize on Startup 
If you select the Minimize on Startup check box, the MAGic user 
interface will be minimized when you start the program. Click MAGic 
Screen Magnification in the taskbar or press MAGic Key+U to display the 
user interface. 

Run MAGic at Startup  
If you select the Run MAGic at Startup check box, MAGic automatically 
starts when you start Windows.  

Prompt to Save Settings on Exit 
Select the Prompt to Save Settings on Exit check box if you want MAGic 
to ask you to save your settings when you quit the program or shut 
down your computer. If you do not select this check box, you must press 
CTRL+S or open the File menu and choose Save Settings to save your 
settings. 

Disable Screen Saver 
Select the Disable Screen Saver check box if you want to prevent your 
screen saver from starting while MAGic is running. Your screen saver 
will be enabled again when you quit MAGic. 
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Enable Bilingual User Interface 
Select the Enable Bilingual User Interface check box to change the 
language of MAGic’s menus, dialog boxes, and online help system when 
you switch to your secondary language. The resource files for the 
secondary language must be installed in order to use this feature. Clear 
this check box if you do not want to change the language of MAGic’s 
user interface when you switch to your secondary language with MAGic 
Key+F11. To change your secondary language, open the Speech menu, 
choose Voices, and move to the Secondary Language tab. 

Note:  The current release of MAGic contains only English and 
Spanish resource files.  

Prompt to Overwrite Schemes 
Select the Prompt to Overwrite Schemes check box if you want MAGic to 
ask for confirmation before saving a mouse, cursor, or color 
enhancements scheme with the same name as an existing scheme. If 
you do not select this check box, MAGic will save the new scheme over 
the old scheme without asking for confirmation. 

Note:  Different types of schemes can have the same name. For 
example, a cursor enhancement scheme can have the same 
name as a mouse enhancement scheme. 

Run MAGic from System Tray 
Select the Run MAGic from System Tray check box if you do not want 
the MAGic window to appear in the Windows taskbar with other 
programs that you are currently using. In addition, the MAGic window 
does not appear in the list of active windows when you press ALT+TAB. 
An icon appears in the Windows system tray (located in the bottom right 
corner of the screen) to indicate that MAGic is running. Double-click this 
icon or press MAGic Key+U to display the MAGic program window. If you 
minimize the MAGic window, it is removed from the taskbar again. 

 



 

 25 

Note:  You must restart MAGic before any change to this option can 
take effect. 

Enforced Write Protect 
It is recommened that you leave the Enforced Write Protect check box 
cleared if you use your computer for multi-session work, such as 
Citrix/Terminal Services remote access or fast user switching. You 
should also leave this check box cleared if your network administrator 
uses service management software to install updates or make changes 
to your computer remotely. If you select this check box, your network 
administrator cannot update or modify MAGic files remotely. 

Getting Help  

Online Help System 
To access MAGic’s online help system, select Help Topics from the Help 
menu, which is located on the menu bar of the MAGic application 
window. Use the Contents tab to navigate the help system. Use the 
Index or the Search tabs to search for specific topics within the help 
system. If you want MAGic to read the help topics to you, position the 
mouse pointer toward the beginning of the help page, and press MAGic 
Key+SPACEBAR. You can move to the next topic by clicking the "Next" 
link at the bottom of the page. To return to the previous topic, click the 
"Back" link.  

What’s This? Help 
MAGic’s What’s This? help is context-sensitive help that you can use as 
a reference when working with MAGic’s user interface or dialog boxes. 
Press SHIFT+F1 on any button on the user interface, or control in a 
dialog box to see a brief description of the purpose of the control and 
how to use it. 
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MAGic User’s Guide 
We provide you with the content of the MAGic online help system in the 
MAGic User’s Guide, which is printed in large text for easier reading. 
This book contains detailed descriptions of MAGic’s features, and also 
pull-out reference cards. 

MAGic Basic Training 
Listen to the MAGic Basic Training to learn the fundamentals of using 
MAGic Screen Magnification. For more information, see Basic Training 
on page 26. 

Technical Support 
If you do not find the answers to questions or problems that you have, 
contact Freedom Scientific Technical Support, (727) 803-8600. 

About MAGic  
Select About MAGic from the Help menu on the MAGic user interface to 
view the version number of MAGic you are currently running.  

Basic Training 
The basic training for MAGic is included in DAISY format on your MAGic 
program CD. When you install MAGic, you are also asked if you want to 
install these materials. You can listen to and read the training modules 
by using the FSReader Demo DAISY reader included with MAGic. To start 
FSReader Demo, open the Start menu, open the MAGic program group, 
and choose FSReader Demo. Alternatively, you can open the MAGic Help 
menu and choose Training. 

After you start FSReader Demo, a list of all DAISY books in the current 
folder appears. To begin the basic training, select the 
"MAGic_Basic_Training" DAISY book and choose Open. For more 
information on using FSReader, select the 
"FSReaderGettingStarted_JAWS_MAGic" DAISY book and choose Open.  
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These training modules are designed to give you a basic overview of 
MAGic. You will learn how to change your magnification and speech 
preferences, along with several other techniques. All users are 
encouraged to take advantage of this training.  

Note:  FSReader does not support Windows NT 4.0. 
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Chapter 2 
Navigating MAGic 

Use Your Mouse and Your Keyboard 
With MAGic, you can use both your mouse and your keyboard to access 
most features. You decide what is best for you. Many people use a 
combination of the two. The MAGic documentation gives you 
information on how to perform actions with both the keyboard and the 
mouse. For example, you can either press ALT+F to access the File 
menu, or you can point and click the word File with the mouse.  

Using the Keyboard with MAGic 

The MAGic Key 
When you use the keyboard in MAGic, the most important thing to know 
is the MAGic Key. The default MAGic Key is the CAPS LOCK key on your 
keyboard. Using the MAGic Key in combination with other keys activates 
a MAGic command if one is assigned, otherwise it will pass the key 
combination through to the application. Pressing the MAGic Key by itself 
and releasing it will not carry out any action. You can specify what key 
you use for your MAGic Key in the MAGic Key dialog box, which is 
activated from the Keyboard menu. Your choices include:  Extended 
INSERT (found on the six pack), NUM PAD INSERT, either INSERT, or 
SCROLL LOCK (the key just above HOME). 

Pass the MAGic Key Through 

If your MAGic Key is set to the default of CAPS LOCK, how do you use 
your CAPS LOCK key as usual?  

Press the CAPS LOCK key twice quickly, and caps lock will turn on. To 
turn off caps lock, press the key twice quickly. Use this double key press 
to pass through any of the MAGic Keys that you use. For instance, if you 
select INSERT as your MAGic Key, press the INSERT key twice to use the 
actual insert function.  
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Pass Through Key Command  

If you have an application that uses the same keystroke combination as 
one assigned to MAGic, you can pass the keystroke combination through 
to the application, so it will not function as a MAGic keystroke in that 
instance.  

Press MAGic Key+3 (on the numbers row), and then press the keystroke 
you want to use in the application. Use the Pass Through command for 
any key combination that is used in MAGic and in other applications.  

With MAGic, you can customize all of your keystrokes in the Keyboard 
Assignments dialog box, activated from the Keyboard menu. If you 
specify certain keystrokes for use in MAGic, you may need to use these 
keystrokes in other applications. Keep the Pass Through command of 
MAGic Key+3 in mind when you customize keystrokes. 

Customizing the Keyboard  
The Keyboard menu allows you to customize how you use your PC's 
keyboard with MAGic. This menu allows you to re-assign the MAGic Key 
to a different key and manage shortcut keys. The Keyboard menu 
provides the following options: 

• Choose MAGic Key from the Keyboard menu to change which key is 
assigned to the MAGic Key.  

• Choose Keyboard Assignments from the Keyboard menu to view 
the current hot keys assigned to actions, assign different hot keys, 
remove hot keys, or restore the hot keys to the default settings.  

Refer to Chapter 6 Keyboard for detailed information on these 
commands. 
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Using the Mouse with MAGic  

Point and Click 
With MAGic you don’t have to learn keystrokes to perform actions. You 
can use the mouse to point at items on the user interface, and click the 
buttons to activate features. For example, to enable mouse 
enhancements, just point at the Mouse Enhancements button and press 
the left mouse button.  

If you are not sure how to activate a feature, use your mouse to open 
the menus and find the feature you need.  

Left Click vs. Right Click 
The left mouse button is the more commonly used mouse button, 
because it activates buttons and menus. Alternatively, the right mouse 
button provides useful shortcuts to many items found under MAGic’s 
menus.  

You can right-click many of the buttons on the user interface to see a 
context menu. Depending on where you right-click on the user interface, 
the menus change. Use your right mouse button to access the most 
common features associated with the buttons on the MAGic user 
interface.  

If you are not a mouse user, you can activate context menus with the 
APPLICATION Key on the keyboard. Locate the APPLICATION Key just to 
the left of the right CTRL key in the bottom row on your main keypad. 
Use the TAB key to place the focus on the button that you want to see 
the context menu for, and press the APPLICATION Key to open the 
menu. Then use the UP and DOWN ARROWS to move through the menu 
choices. 
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Chapter 3 
User Interface 

The MAGic user interface contains everything you need to customize 
magnification and speech to fit your needs. The user interface 
automatically opens when you launch MAGic. If you want to make the 
user interface active while you are working in another window, click 
MAGic Screen Magnification in the Windows taskbar or press MAGic 
Key+U. 

The MAGic user interface consists of the title bar, the menu bar, and the 
Quick Access Window.  

  

The title bar is the bar across the top of the application, which says, 
“MAGic Screen Magnification.” The menu bar is located just below, and 
contains the File, Magnification, Speech, Keyboard, and Help menus. 
The Quick Access Window is the main area of the user interface.  

Title Bar 
Locate the MAGic title bar at the very top of the window. It reads, 
“MAGic Screen Magnification.” Press MAGic Key+T or INSERT+END to 
hear the text of the title bar. If speech is not enabled you will not hear 
anything. 
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Click the M icon on the left side of the title bar, or press ALT+SPACEBAR 
to see the control menu, which includes options to Move, Minimize, and 
Close. Click the  button, or press ALT+SPACEBAR, N to minimize the 
application. Click the  in the top right corner, or press ALT+F4, to exit 
MAGic.  

Menu Bar 
The MAGic menu bar contains five menus: File, Magnification, Speech, 
Keyboard, and Help. 

 

Tip:  To open these menus with the keyboard, press ALT and the 
underlined letter. For example, press ALT+F to open the File 
menu. 

The File menu contains the following commands:  

• Preferences – This command lets you change your preferences for 
MAGic. For more information, refer to Changing you Preferences on 
page 20. 

• Save Settings – When you change options found in the 
Magnification and Speech menus, select Save Settings to store 
your preferences for the next time you run MAGic.  

• Restore Factory Settings – Select this menu item to reset MAGic 
options to the state they were in when you installed MAGic. 
Selecting this option returns all features to the original settings, 
except hot keys that you customized. Activate the Restore Defaults 
button in the Keyboard Assignments dialog box to revert all hot 
keys to their original configurations. 

• Exit – Choose Exit to quit MAGic.  

Find information about the Magnification, Speech, and Keyboard menus 
in Chapter 4 Magnification, Chapter 5 Speech, and Chapter 6 Keyboard.  
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Quick Access Window 
MAGic’s Quick Access Window provides controls to help you easily 
access the main MAGic features. Use the buttons on the user interface 
to control both magnification and speech. Left click the button to 
activate the feature, and right-click the button to see a context menu 
for some of the buttons.  

Tip:  If you want to use the keyboard with the Quick Access 
Window, press TAB to move through the buttons and options. 
Press SPACEBAR to activate the selected button, or press the 
APPLICATION Key to open the context menu. 

 

The Magnification Buttons 
Use the blue buttons on the MAGic user-interface to control 
magnification. 

Magnification Button 

Use this button to enable or disable magnification. 

 

Use the Magnification button to turn magnification on or off. If the M on 
the magnification button is animated, then magnification is turned off. 

Hot Keys 

Enable or Disable 
Magnification 

MAGic Key+DELETE 
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Magnification Level Buttons 

Increase or decrease the magnification level with these buttons. 

 

The upper button, with the upward arrow image, increases the 
magnification level, while the lower button, with the downward arrow 
image, decreases the magnification level. The number between the two 
buttons shows the current magnification level. The default level of 
magnification is 2× (2× is equivalent to two times the normal screen 
display). If you press the TAB key to move into the area where the 
number appears, use your UP and DOWN ARROW keys to increase or 
decrease magnification. 

It is possible to change the magnification level to 1. This allows you to 
continue using magnification features, such as mouse, cursor, and color 
enhancements, while viewing the entire screen area. You can also 
choose from nine incremental magnification levels between 1× and 2× 
magnification. 

Hot Keys 

Increase Magnification MAGic Key+NUM PAD PLUS 
or CTRL+EQUALS 

Decrease Magnification MAGic Key+NUM PAD MINUS 
or CTRL+DASH 

Magnified Views List 

Select your favorite magnified view from the list on the MAGic user-
interface. 
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You can select Full, Lens, Dynamic Lens, Overlay, or Split for your 
magnified view. Full magnifies the entire screen, while each of the 
others only magnifies a portion of your screen at a time. Right-click the 
Magnified Views list to quickly access the properties for the Split, Lens, 
Dynamic Lens, or Overlay views. 

Mouse Enhancements Button 

Apply enhancements to your mouse pointer with this button. 

 

Use the Mouse Enhancements button to enable/disable enhancements 
and modifications for your mouse pointer. These enhancements make 
the mouse pointer easier to track and maneuver on your screen. To 
specify which enhancements you want to use, open the Magnification 
menu and choose Mouse Enhancements. 

Tip:  You can right-click this button to quickly choose a new mouse 
enhancements scheme or customize the appearance of the 
mouse in the magnified or unmagnified area of the screen. 
For more information on mouse enhancements, refer to 
Mouse Enhancements on page 44. 

Hot Keys 

Toggle Mouse Enhancements MAGic Key+F4 

Cursor Enhancements Button 

Apply enhancements to your cursor with this button. 

 

Use the Cursor Enhancements button to enable/disable enhancements 
for your cursor. These enhancements make the cursor easier to follow 
when editing or writing text. To specify which enhancements you want 
to use, open the Magnification menu and choose Cursor Enhancements.  
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Tip:  You can right-click this button to quickly choose a new cursor 
enhancements scheme or customize the appearance of the 
cursor in the magnified or unmagnified area of the screen. 
For more information on cursor enhancements, refer to Cursor 
Enhancements on page 47. 

Hot Keys 

Toggle Cursor Enhancements MAGic Key+F8 

Note:  Cursor enhancements are not available in Windows 95, 98, or 
ME. 

Color Enhancements Button 

Change how your screen displays colors with this button. 

 

Use the Color Enhancements button to enable/disable color 
enhancements. This feature allows you to replace colors, adjust the 
brightness and contrast, apply tinting, and invert the brightness and 
colors of your display. You can apply color enhancements to the 
magnified area, unmagnified area, or both. To specify your color 
enhancement settings, open the Magnification menu and choose Color 
Enhancements. 

Tip:  You can right-click this button to quickly choose a new color 
enhancements scheme or customize your color enhancements 
for the magnified or unmagnified area of the screen. For 
more information on color enhancements, refer to Color 
Enhancements on page 53. 

Hot Keys 

Toggle Color Enhancements MAGic Key+F12 

Note:  If you are using Windows 95, 98, or ME, choosing the Color 
Enhancements button or pressing MAGic Key+F12 inverts the 
colors of the screen instead of toggling color enhancements. 
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Resize View Button 

When working in Split, Overlay, or Lens, or Dynamic Lens views, use the 
Resize View button to resize or move the view. 

 

You must be in the Split, Overlay, Lens, or Dynamic Lens view, and 
magnification must be active to use the Resize View button. When the 
Resize View button is available it appears blue. If it is gray, you need to 
turn on magnification, by choosing the Magnification button on the 
MAGic user interface. After you choose the Resize View button, notice 
that the cursor changes shape, and that MAGic automatically minimizes 
the user-interface. The shape of the mouse indicates in which direction 
you can click and drag your mouse to move or resize your view. 

 

If the pointer appears as an X, like above, it is not positioned over the 
view or one its borders. The X indicates that from this position the view 
cannot be resized or moved. 

 

A bi-directional cross indicates the ability to move the view to a 
different location on your screen. Click the view, and while holding the 
mouse button down drag the view to another location. Split view only 
moves to the top, bottom, left, or right edge of your screen, while you 
can move Overlay to any location on your screen. 

 

A vertical pointer indicates that resizing will occur in a vertical direction, 
larger or smaller. 

 

A horizontal pointer indicates that resizing will occur in a horizontal 
direction, either larger or smaller. 
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A diagonal pointer indicates that resizing will occur in both vertical and 
horizontal directions. MAGic only exhibits the diagonal mouse when you 
position the mouse over the corner of the view. The diagonal pointer is 
only available for the Overlay, Dynamic Lens, and Lens views. 

Locator Button 

Activate the Locator with this button. 

 

Use the Locator button to activate the Locator, which you can use to find 
items on your screen. Move the Locator with your mouse or your arrow 
keys. Change the properties of the Locator with the Locator Properties 
dialog box, which you can access from the Magnification menu. Also you 
can right-click the Locator button to change the style and border of your 
Locator. 

Hot Keys 

Enable Locator Mode MAGic Key+F10 

Disable Locator Mode ESC 

Smoothing Button 

Toggle Smoothing on or off with this button. 

 

Choose the Smoothing button to smooth the appearance of jagged 
letters in a magnified state. Choose the button again to turn smoothing 
off. 
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The Speech Buttons 
The three orange buttons at the bottom right of the MAGic user-
interface allow you quick access to MAGic’s speech capabilities. From 
here, you can enable or disable speech, mouse echo, and typing echo. 

Speech Button 

Click this button to enable or disable speech.  

 

If the button appears with the mouth opened, like this one, then speech 
is enabled. 

 

If the button appears with the mouth closed, then speech is disabled.  

Right-click the Speech button to switch between your primary and 
secondary languages or to customize how MAGic speaks. 

Hot Keys 

Toggle Speech MAGic Key+F3 

Mouse Echo Button 

Click this button to toggle the Mouse Echo.  

 

If the button appears with white lines to the right, mouse echo is turned 
off. 

 

If the button appears with black lines to the right, mouse echo is turned 
on. To set mouse echo to announce lines or words, right-click the button 
and make your selection from the context menu. You can also set 
mouse movement to stop speech from this context menu. 
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Hot Keys 

Mouse Echo Toggle MAGic Key+M 

Typing Echo Button 

Click this button to toggle the Typing Echo on and off. 

 

If the Typing Echo button appears to have white lines extending from 
the right side, then typing echo is turned off. 

 

If the Typing Echo button has black lines extending from the right side, 
then typing echo is turned on. To specify the typing echo to words or 
characters, you need to activate the Typing Echo dialog box from the 
Speech menu, or right-click and choose Automatically Speak. Choosing 
Keystrokes to Echo lets you modify how much MAGic echoes back to 
you. 
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Chapter 4 
Magnification 

Magnification Features 
With MAGic’s extensive magnification features, you can customize your 
display to fit your low vision needs. 

The Magnification menu, found on the menu bar, contains all of the 
controls to change the appearance of your display. 

 

The first item on the Magnification menu, Enable Magnification, lets you 
activate or deactivate magnification. If the menu item appears with a 
checkmark next to it, magnification is enabled. If there is no checkmark, 
magnification is disabled. 

Remember that the blue buttons on the user-interface allow you quick 
access to the basic magnification features. 
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The Magnification Menu 

Display 
From the Magnification menu, choose Display to change the magnified 
view, magnification level, amount of vertical stretch, and text 
smoothing. 

 

View 

Select the magnified view you want to use. Each view is described 
briefly below.  

Tip:  To change the properties for these views, open the 
Magnification menu and choose View Properties. 

• Full magnifies the entire screen.  

• Lens opens a small rectangular window, which is magnified, while 
leaving the remaining desktop unmagnified. The lens moves 
around the screen as you move your mouse or when the focus 
moves. 

• Overlay creates a magnified window on the corner of the screen, 
while the rest of the screen remains unmagnified. This is similar 
to the Lens View, although the Overlay View does not move around 
the screen. 
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• Dynamic Lens opens a small rectangular window, which is 
magnified, while leaving the rest of the screen unmagnified. This 
window follows the mouse pointer or your current location within a 
document or dialog box if you are using the keyboard. In addition, 
when you move to a dialog box option or menu command, MAGic 
automatically resizes the lens so that it only magnifies the 
currently selected item. 

• Split allows you to see both an unmagnified area and a magnified 
one at the same time. The Split View opens a magnified window 
on part of your screen, but leaves the other part unmagnified as a 
reference. 

Views with Level 1 Magnification 

You can use all of the magnified views in any magnification level, 
including 1×. Using these views with level 1 magnification can be 
helpful if you invert the colors of either the magnified or unmagnified 
area. You then have two images, one with normal colors, and one with 
inverted colors. 

To quickly switch from your current magnification level to 1x 
magnification, press MAGIC Key+DELETE+SHIFT. You can carry out this 
command again to switch back to your previous magnification level. 

Magnification Level 

Press the UP or DOWN ARROW keys to increase or decrease the current 
magnification level. Magnification levels range from the same size as 
the normal display, all the way up to 16 times the size of the normal 
display. 

Tip:  You can choose from nine incremental magnification levels 
between 1× and 2× magnification. 

Vertical Stretch 

Vertical stretch allows you to stretch the display to make images taller 
while maintaining the character’s current width. 
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Smooth Text 

Smoothing compensates for the stair-step effect that occurs as screen 
objects get larger during magnification. Smoothing is on by default. You 
can turn smoothing on or off with the Smoothing check box.  

Mouse Enhancements 
From the Magnification menu, choose Mouse Enhancements to control 
the appearance of your mouse in the magnified and unmagnified areas 
of your screen. Mouse enhancements make the mouse pointer easier to 
track and maneuver on your screen. The Magnified Area and 
Unmagnified Area tabs provide the same enhancement options. 

The Mouse Schemes tab lets you save your cursor enhancements 
settings as a scheme or switch to a different scheme. For more 
information on schemes, refer to Using Schemes on page 47. 

Select the Enable Mouse Enhancements check box on any of the tabs in 
this dialog box to apply enhancements to the mouse pointer. Clear this 
check box to disable mouse enhancements. You can also use the Mouse 
Enhancements button to enable or disable mouse enhancements. 
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Mouse Attributes 

The options in the Mouse Attributes area allow you to customize the 
appearance of your mouse pointer.  

Color 

Select a color for your mouse pointer in the Color list. To use the 
original system colors for the mouse pointer, choose Original. To invert 
the brightness or colors of screen areas covered by the mouse pointer, 
choose Invert Brightness or Invert Colors.  

To choose from additional colors, activate the Define Custom Color 
button and choose one of the available colors from the palette. 

Transparency 

Use the Transparency slider to adjust the transparency level of the 
mouse pointer. A higher level of transparency allows you to see text and 
images beneath the area covered by the mouse pointer. 

Note:  You cannot change the transparency if you are using Windows 
95, 98, or ME. 

Size 

You can use the Size list to increase the proportions of the mouse 
pointer. Choose from standard size or large size. 

Mouse Enhancement Attributes 

Enhancements are used to further modify the mouse pointer by making 
it easier to locate and maneuver on the screen. 

Style 

In the Style list, choose one of the following enhancement types to 
apply to your mouse pointer: 

• Short Crosshair - Displays intersecting horizontal and vertical bars 
that are centered on your mouse pointer. You can adjust the size 
of these bars by using the Length and Height sliders. 
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• Long Crosshair - This style is similar to short crosshair, but the 
horizontal and vertical bars extend to the edges of the view. 

• Oval - Displays an oval around the mouse pointer. You can adjust 
the size of the oval by using the Length and Height sliders. 

• Box - Displays a box around the mouse pointer. You can adjust the 
size of the box by using the Length and Height sliders. 

• Oval Scope - Combines the short crosshair and oval styles. 

• Box Scope - Combines the short crosshair and box styles. 

• Long Box Scope - Combines the long crosshair and box styles. 

• Long Oval Scope - Combines the long crosshair and oval styles. 

Color 

In the Color list, choose a color for the enhancement style you selected. 
To invert the brightness or colors of screen areas covered by the 
enhancement, choose Invert Brightness or Invert Colors.  To choose 
from additional colors, activate the Define Custom Color button and 
choose one of the available colors from the palette.  

Display 

In the Display list, choose when MAGic should apply enhancements to 
the mouse pointer: 

• Always - The mouse enhancements are always active and visible 
on the screen. 

• Mouse Moving - The enhancements are only visible when the 
mouse pointer is moving. 

• Mouse Not Moving - The enhancements are only visible when the 
mouse pointer is stationary. 

• When MAGic Key is Pressed - The enhancements only appear when 
you press the MAGic Key. 

Note:  If you are using Windows 95, 98, or ME, the mouse 
enhancements are always active and visible on the screen. 
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Transparency 

Use the Transparency slider to adjust the transparency level of the 
mouse enhancement. A higher level of transparency allows you to see 
text and images beneath areas covered by the enhancements. 

Note:  You cannot change the transparency if you are using Windows 
95, 98, or ME. 

Thickness 

Use the Thickness slider to adjust the thickness of the lines of the 
enhancement style you selected. Increased thickness makes the 
enhancements easier to see and causes them to stand out more. 
Decreased thickness causes the enhancements to appear more subdued 
and lets you see more of the screen. 

Length and Height 

Use the Length and Height sliders to adjust the size of the mouse 
enhancement style you selected. If you selected the oval, box, long oval 
scope, or long box scope style, these sliders let you control the width 
and height of the oval or box. If you selected the short crosshair style, 
these sliders let you change the length and height of the horizontal and 
vertical bars. 

Using Schemes 

A scheme is a group of settings that can be saved and used in certain 
programs or circumstances. Schemes allow you to quickly switch 
between different configurations of enhancements, according to your 
current needs. For example, you can create a mouse enhancement 
scheme specifically for proofreading documents and another scheme for 
browsing Web pages.  
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The currently selected scheme is displayed in the Scheme list. To switch 
to a different scheme, choose a new scheme from the list and then click 
Apply or press ALT+A. If you select the Automatically Apply Schemes 
check box, MAGic applies the new enhancement settings as soon as you 
select a scheme. 

Tip:  You can also select a scheme directly from the Quick Access 
Window. To do this, right-click the Mouse Enhancements, 
Cursor Enhancements, or Color Enhancements button and 
then choose a scheme from the context menu. 

The Magnified Area Description and Unmagnified Area Description boxes 
show the current enhancement settings for the magnified area and the 
unmagnified area.  

Creating New Schemes 

To create a new scheme, do the following: 

1. Use the Magnified Area and Unmagnified Area tabs to define 
enhancement settings for the magnified and unmagnified areas.  
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2. On the Mouse Schemes tab, click Save As or press ALT+S to 
create a new scheme based on your current settings.  

3. Enter a name for the scheme and then press ENTER. The new 
scheme appears in the Scheme list. 

Modifying Schemes 

To modify an existing scheme, do the following: 

1. Select the scheme you want to modify in the Scheme list. 

2. Change the enhancement settings for the magnified and 
unmagnified areas. 

3. On the Mouse Schemes tab, click Save As or press ALT+S. 

4. The name of the currently selected scheme displays in the Save 
Scheme dialog box. Press ENTER to save your modifications. 

Deleting Schemes 

To delete a scheme, do the following: 

1. Select the scheme you want to delete in the Scheme list. 

2. Click Delete or press ALT+D to delete the currently selected 
scheme.  

Restoring Factory Schemes 

Click Restore Factory Schemes or press ALT+R to revert to the original 
Factory Settings scheme included with MAGic. Schemes that you or 
other users have created remain unchanged. 

Cursor Enhancements 
From the Magnification menu, choose Cursor Enhancements to 
customize the appearance of your cursor in the magnified and 
unmagnified areas of the screen. Cursor enhancements make the cursor 
easier to follow when editing or writing text. The Magnified Area and 
Unmagnified Area tabs provide the same enhancement options. 

Note:  Cursor enhancements are not available in Windows 95, 98, or 
ME. 
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The Cursor Schemes tab lets you save your cursor enhancements 
settings as a scheme or switch to a different scheme. For more 
information on schemes, refer to Using Schemes on page 47. 

Select the Enable Cursor Enhancements check box on any tab in this 
dialog box to apply enhancements to your cursor. Clear this check box to 
disable the cursor enhancements. You can also use the Cursor 
Enhancements button to enable or disable cursor enhancements. 

 

Cursor Attributes 

In the Color list, choose a new color for the flashing cursor that appears 
when you are typing text into an edit box, document, and so on. To use 
the original system color for the cursor, choose Original. To choose from 
additional colors, activate the Define Custom Color button and choose 
one of the available colors from the palette.  
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Sample Cursor Enhancement 

This area allows you to preview your cursor enhancement settings. 
MAGic displays a sample of you current cursor enhancements using the 
text in this area. This lets you adjust the enhancements to achieve the 
desired effect before applying them.  

Cursor Enhancement Attributes 

The Cursor Enhancement Attributes area allows you to choose a cursor 
enhancement style. You can also adjust the appearance and size of the 
enhancement and when it displays on your screen.  

Style 

In the Style list, choose one of the following enhancement styles: 

• None - The cursor appears as a blinking vertical bar, with no 
additional enhancements. 

• Oval - A small area around the cursor is surrounded by an oval. 

• Triangle - Two small triangles appear above and below the current 
position of the cursor. 

• Box - The immediate area around the cursor is surrounded by a 
small rectangle. 

• Line - Perpendicular lines appear beneath the text and a small 
vertical line indicates the exact position of the cursor. 

Color 

In the Color list, choose a color for the enhancement style you selected. 
To invert the brightness or colors of screen areas covered by the 
enhancement, choose Invert Brightness or Invert Colors. To choose from 
additional colors, activate the Define Custom Color button and choose 
one of the available colors from the palette.  

Display 

In the Display list, choose when MAGic should apply enhancements to 
the cursor: 
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• Always - The cursor enhancements are always active and visible on 
the screen. 

• Cursor Moving - The enhancements are only visible when the 
cursor is moving, such as when you are typing text or using the 
arrow keys. 

• Cursor Not Moving - The enhancements are only visible when the 
cursor is stationary. 

• When MAGic Key is Pressed - The enhancements only appear 
when you press the MAGic Key. 

Transparency 

Use the Transparency slider to adjust the transparency level of the 
cursor enhancement. This is useful if your cursor enhancement 
frequently obscures the surrounding text. Higher levels of transparency 
allow you to see text and images beneath the enhancement. 

Thickness 

Use the Thickness slider to adjust the thickness of the cursor 
enhancement. Thicker cursor enhancements are easier to see and stand 
out more. Thinner cursor enhancements are more subdued and let you 
see more of the text. 

Length 

Use the Length slider to adjust the horizontal size of the cursor 
enhancement style. This affects how much text is included within the 
oval, box, and line enhancements. 

Height 

Use the Height slider to adjust the vertical size of the cursor 
enhancement style. This affects the height of the oval and box 
enhancements and increases the length of the vertical portion of the 
line enhancement. 
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Color Enhancements 
From the Magnification menu, choose Color Enhancements to define 
how MAGic displays colors on your screen. This feature allows you to 
replace and swap colors, adjust the brightness and contrast, apply 
tinting, make your screen black-and-white (monochrome), and invert 
the brightness and colors of your display. You can apply color 
enhancements to the magnified area, unmagnified area, or both. The 
Magnified Area and Unmagnified Area tabs provide the same 
enhancement options. 

Note:  If you are using Windows 95, 98, or ME, you can only use the 
Color Enhancements command to invert the colors of your 
screen. 

The Color Schemes tab lets you save your color enhancements settings 
as a scheme or switch to a different scheme. For more information on 
schemes, refer to Using Schemes on page 47. 

Select the Enable Color Enhancements check box on any tab in this 
dialog box to apply color enhancements to your display. Clear this check 
box to disable the color enhancements. You can also use the Color 
Enhancements button to enable or disable color enhancements. 
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Invert Brightness 

Select this check box if you want MAGic to invert the brightness of 
colors on your display. Dark colors will appear lighter, while light colors 
will appear darker. For example, if you select this check box, black text 
becomes white text and dark blue becomes light blue.  

Invert Colors 

Select this check box to reverse the colors that are displayed on your 
screen.  

Invert Black and White 

If you select this check box, MAGic replaces the color black with white 
and the color white with black. 

Restore System Colors Button 

Click Restore System Colors or press ALT+Y to revert to your default 
Windows color settings.  
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Brightness 

Use the Brightness slider to adjust the brightness of your screen. 
Brightness determines how light or dark colors appear. Move the slider 
down to reduce the brightness, move it up to increase the brightness. 

Contrast 

Use the Contrast slider to adjust the contrast of you screen. Contrast 
determines the difference between lighter and darker areas. Move the 
slider down to reduce the contrast, move it up to increase the contrast.  

Monochrome and Tint 

The Monochrome and Tint area allows you to tint your screen with a 
color or make the screen monochrome (black-and-white). MAGic only 
applies these settings if you select the Enable Monochrome and Tint 
check box. 

Color 

In the Color list, choose the color you want MAGic to use to tint your 
screen. Choose Grayscale if you want your screen to appear monochrome 
(black-and-white). To choose from additional colors, activate the Define 
Custom Color button and choose one of the available colors from the 
palette. 

Level 

Use the Level slider to adjust the luminescence, or brightness, of the 
tinting. Move the slider to the left to make the color appear darker, 
move it to the right to make the color appear brighter. 

Blend 

Use the Blend slider to control the intensity of the tinting. Move the 
slider to the left for strong tinting. At stronger levels, the tinting affects 
the color of almost everything on the screen. Move the slider to the 
right for a lower level of tinting. At the lowest levels, the tinting only 
slightly alters the colors on your screen. 
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Color Switching 

The Color Switching area allows you to define rules that switch certain 
colors on your screen with colors of your choice. MAGic only applies 
these color switching rules if you select the Enable Color Switching 
check box. 

To create a new rule: 

1. Select the Replace Color radio button if you want to use one color 
instead of another. Select the Swap Colors radio if you want to 
switch two colors on your screen. For example, if you select 
Replace Color and choose to replace red with blue, all red objects 
will appear blue instead. If you select Swap Colors and choose to 
swap red and blue, all red objects appear blue, and all blue objects 
appear red. 

2. Select one color in the Color list and a second color in the With 
Color list. If you are creating a color replacement rule, MAGic will 
replace the first color with the second color. If you are creating a 
color swapping rule, MAGic will switch these two colors on your 
screen. 

3. Click Add Rule or press ALT+D to define your new rule and add it 
to the list. 

Follow the steps above to add more rules as necessary. To delete a rule, 
select it in the Active Color Switches list and click Remove Rule or press 
ALT+M.  
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View Properties 
From the Magnification menu, choose View Properties to customize how 
the Split, Lens, Overlay, or Dynamic Lens views appear on your screen. 

Split View 

The Split tab allows you to define properties for the Split view. Split 
view allows you to see both an unmagnified area and a magnified area 
at the same time. The Split view opens a magnified window in part of 
your screen, but leaves the other part unmagnified as a reference. 

 

Color 

Select a color for the border that separates the two parts of the split 
screen. 

Thickness 

Move the slider bar to increase or decrease the thickness of the divider 
that separates the two parts of the split screen. The bars above the 
slider indicate the widths you can select. 



 

58 

Position 

Select where you want the magnified area to appear on the screen.  

Size 

Select how much of the screen you want the magnified area occupy. For 
example, if you select Quarter, the magnified area occupies 25% of the 
available screen area. 

If you select Line, the magnified area of the screen occupies a size equal 
to one line of text, as specified in the Point Size box of the Panning 
dialog box. By default, Custom size is equivalent to one-third of the 
screen, but you can change this by using the Resize View button. 

Lens 

The Lens tab allows you to define properties for the Lens view. Lens 
view opens a small rectangular window, which is magnified, while 
leaving the remaining desktop unmagnified. The lens moves around the 
screen as you move your mouse or when the focus changes. 

 

Color 

Select a color for the border of your lens. 
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Thickness 

Move the slider bar to increase or decrease the thickness of the lens 
border. The bars above the slider indicate the widths you can select. 

Overlay 

The Overlay tab allows you to define properties for the Overlay view. 
Overlay view creates a magnified window in the corner of the screen, 
while the rest of the screen remains unmagnified. This is similar to the 
Lens view, but the Overlay view does not move around the screen. 

 

Color 

Select a color for the border of your overlay. 

Thickness 

Move the slider bar to increase or decrease the thickness of the border. 
The bars above the slider indicate the widths you can select. 
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Dynamic Lens 

The Dynamic Lens tab allows you to define properties for the Dynamic 
Lens view. Dynamic Lens view opens a small rectangular window, which 
is magnified, while leaving the rest of the screen unmagnified. This 
window follows the mouse pointer or your current location within a 
document or dialog box if you are using the keyboard. In addition, when 
you move to a dialog box option or menu command, MAGic 
automatically resizes the lens so that it only magnifies the currently 
selected item. If you type in an edit box or document window, the lens 
expands to the width of the entire screen so you can see as much of the 
text as possible.  

 

Color 

Select a color for the border of your lens. 

Thickness 

Move the slider bar to increase or decrease the thickness of the lens 
border. The bars above the slider indicate the widths you can select. 
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Quick View Frame 
The Quick View Frame feature allows you to specify regions of the 
screen (called frames) that you can monitor while you work in other 
areas. MAGic can display one of these frames in the magnified area so 
you can see any changes or updates to that part of the screen. To 
choose which frame you want to display, or to customize the frame's 
position, border color, and color enhancements, open the Magnification 
menu and choose Quick View Frame. 

Note:  The Quick View Frame is only visible while you are using the 
Full view and have magnification enabled. In addition, the 
Quick View Frame is not available in Windows 95, 98, or ME. 

Properties  

The Properties tab allows you to select or modify the active frame and 
change the frame’s position and border color. 
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Enable Quick View Frame 

Select the Enable Quick View Frame check box to display the active 
frame on your screen in the location specified in the Frame Position list. 
Clear this check box to hide the Quick View Frame.  

Tip:  You can also press MAGic Key+Q to turn the Quick View 
Frame on or off. 

Active Frame 

In the Active Frame list, choose the frame that you want MAGic to 
display. You can create and save any number of frames and then choose 
the frame the best suits your current needs. To create a frame, do the 
following:  

1. Move the mouse pointer to the top left corner of the region you 
want to enclose within the frame and press MAGIC Key+LEFT 
BRACKET. 

2. Move the mouse pointer to the bottom right corner of the region 
and press MAGic Key+RIGHT BRACKET. 

Tip:  To quickly create a frame that is automatically sized to fit a 
dialog box option, move your pointer to the option and press 
MAGic Key+LEFT BRACKET twice quickly. 

3. Type a name for this frame, then click OK or press ENTER. This is 
the name that will appear in the Active Frame list. 

4. Ensure that the frame is positioned over the area of the screen 
that you want to monitor. You can move the frame to another 
location by dragging the frame’s title bar. 

5. If you want to resize the frame, move your pointer over a corner or 
edge of the frame border. When the pointer changes to a double-
headed arrow, drag the border in the desired direction. 

6. When you have finished resizing and positioning the frame, click 
Close on the Quick View Manager toolbar (located in the top left 
corner of the screen) or press ESC. Choose Yes when MAGic asks if 
you want to save your changes. 
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Tip: You can press MAGic Key+9 to open the Quick View Manager 
and view/modify any frames you have saved. 

Border Color 

Choose a color for the border of the active frame from the Border Color 
list. 

Frame Position 

Use the Frame Position list to determine where you want the active 
frame to appear on your screen.  

Modify Active Frame Button 

Click Modify Active Frame or press ALT+M to resize or move the frame 
you selected in the Active Frame list. Drag the frame’s title bar to move 
it to another part of the screen. To resize the frame, move your pointer 
over a corner or edge of the frame border. When the pointer changes to 
a double-headed arrow, drag the border in the desired direction. 

Color 

The Color tab lets you apply color enhancements to the active frame. 
You can adjust the brightness and contrast, create color switching rules, 
apply tinting, and more. The options available on this tab are identical 
to those in the Color Enhancements dialog box. For more information on 
these options, refer to Color Enhancements on page 53. 
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Locator  
From the Magnification menu, choose Locator to select a style and 
border color for the Locator. To enable or disable the Locator, use the 
Locator button on the MAGic user-interface. 

When you activate the Locator, the full screen is temporarily presented 
unmagnified. Move the Locator around using the mouse or the arrow 
keys, and use the Locator to find something on your screen. Use PAGE 
UP to move to the top of the screen, PAGE DOWN to go to the bottom, 
HOME to go to the beginning of a line, and END to go to the end of a 
line. After you have located the item, press ENTER or the left mouse 
button to move the magnified area to that portion of the screen. 
Alternatively, you can press ESC to exit the Locator without moving the 
magnified area.  

 

Style 

Choose from three different styles for your locator: 

• Reverse Eyeglass – Shows a square on the screen that is 
magnified while the rest of the screen is normal size. Colors within 
the magnified square are reversed. 

• Eyeglass – Shows a square on the screen that is magnified while 
the rest of the screen is normal size. 
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• Full Cross – Shows a portion of the screen in reversed colors. In 3× 
magnification or higher, the Locator appears with crosshairs 
running through the center of the block. With magnification set to 
2×, the Locator appears as a block of inversed colors. 

Color 

Specify what color border you want to appear around your Locator. The 
customizable border only applies to the Eyeglass and the Reverse 
Eyeglass options.  

Panning 
Panning moves your display either horizontally or vertically, so you can 
browse the screen, locate objects, and read magnified text easier. With 
magnification set at 2× or higher, you can pan automatically or 
incrementally. The advantage of automatic panning is that you can 
review the contents of the screen without using repetitive mouse 
movements. While incremental panning is similar to automatic panning, 
it is different in that your viewing area moves in small, fixed increments 
making it easier for you to explore your focal area.  

Automatic Panning 

Begin automatic panning in any direction by pressing the MAGic Key in 
conjunction with any arrow key. Panning then begins in that direction, 
and continues until you stop it, or until it reaches the edge of the 
screen.  

Note: If you disable Line Wrap in the Panning dialog box, then 
panning will stop at the right edge of the screen when 
panning from left to right.  

Stop Panning 

To stop panning, press the MAGic Key or the ESC key. You can also use 
the arrow key that corresponds with the direction in which you are 
currently panning. 
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Change Panning Direction 

Press the arrow key of the direction in which you want to pan. 

Panning Quick Advance 

Pressing ENTER while panning right scrolls the view to the beginning of 
the next line, pauses, and then continues panning to the right. 

Panning Speed 

Adjust panning speed during panning, or through the Panning dialog 
box. While panning, press NUM PAD PLUS to speed up, and NUM PAD 
MINUS to slow down. The speed adjustment only applies to the current 
direction of Panning. 

Panning Dialog Box 

From the Magnification menu, choose Panning to specify panning 
properties. 
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Speed 

Panning speed is set independently for each panning direction:  forward, 
reverse, or vertically. Panning speed values are between 1 and 50. You 
might want to select different speeds for different directions. As you 
read, you are panning forward, which might require a higher panning 
speed, than reverse. As you move in the reverse direction you are 
probably looking for something, so you would want to go slower. You 
may also want to set vertical panning a bit faster, because you will use 
vertical panning for skimming documents or Web sites.  

Line Wrap 

Select Line Wrap if you want MAGic to automatically wrap to the next 
line when you reach the right edge of the screen while panning. The edit 
spin boxes, below the Line Wrap check box, allow you to control the Line 
Wrap settings.  

Point Size 

You can adjust the vertical distance that MAGic travels between 
successive lines with the line wraps. Point size should correspond to 
your font size. The default setting is 10 points. 

Note: The point size specified here also controls the size of the 
Split View when set to Line.  

Line Delay 

Line Delay controls the length of the delay while panning between lines. 
The Line Delay settings are in tenths of a second. The default setting is 
10 (or one second). 
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Incremental Panning 

Before you can use the Incremental Panning feature you must assign 
hot keys for each incremental direction. To do this, go to the Keyboard 
menu and select Keyboard Assignments. From the Category list, select 
Navigation. Next, select the incremental direction you want to assign a 
hot key to and then choose the Assign Hot Key button. Within the 
Assign Hot Key dialog box type the keystroke you want to use, and then 
press ENTER.  

When you are done assigning hot keys, choose the OK button to exit the 
Keyboard Assignments dialog box. 

Tracking 
Tracking allows MAGic to follow your activity on the screen. For 
example, MAGic can track your mouse pointer so that it always remains 
in the center of the magnified area. To change how MAGic tracks the 
cursor and mouse pointer, as well as menus, dialog boxes, and 
highlighted text, open the Magnification menu and choose Tracking.  

 

Mouse 

To control how MAGic tracks your mouse pointer, select one of the 
following radio buttons: 

• Edge – If you select this option, MAGic follows your mouse pointer 
only when it reaches the edge of the magnified area.  
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• Centered – If you select this option, MAGic continuously follows 
your mouse pointer, ensuring that it is always in the center of the 
magnified area. 

Cursor 

To control how MAGic tracks the cursor when you are typing text, select 
one of the following radio buttons: 

• Edge – If you select this option, MAGic follows your cursor only 
when it reaches the edge of the magnified area.  

• Centered – If you select this option, MAGic continuously follows 
your cursor, ensuring that it is always in the center of the 
magnified area. 

Dialogs and Menus 

The Dialogs and Menus area lets you control how MAGic follows your 
movement through dialog boxes and menus. Select one of the following 
radio buttons: 

• Edge – MAGic automatically moves the magnified area when you 
reach the edge of the screen while moving through dialog boxes 
and menus. 

• Centered – MAGic continuously tracks the active dialog box option 
or menu command, ensuring that it is always in the center of the 
magnified area. 

Document Reading 

To control how MAGic tracks highlighted text during document reading, 
select one of the following radio buttons: 

• Edge – MAGic automatically moves the magnified area when the 
highlight reaches the edge of the screen.  

• Centered – MAGic continuously tracks the highlight, ensuring that 
highlighted text always remains in the center of the magnified 
area. 
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Auto Switch  

If you select this check box, centered and relative mouse tracking is 
temporarily stopped after you stop moving the mouse. The screen 
remains stationary as long as you keep the mouse pointer within the 
boundary of the screen. When you move beyond the edge of the screen, 
tracking starts again. 

Tether to Display 

If you select this check box, the mouse pointer is "tethered," or 
attached, to the magnified display. As soon as you move the mouse, the 
mouse pointer automatically appears at the current magnified location, 
even if it was not visible on the screen. If you do not select this check 
box, MAGic moves to the current location of the mouse pointer when 
you move the mouse. 

Mouse Line Lock  

If you select this check box, you can only move the mouse pointer in 
horizontal and vertical directions. If you move the mouse in a diagonal 
direction, MAGic moves the mouse pointer in the closest direction.  

Track Carets and Cursors  

Select this check box if you want MAGic to track your cursor and mouse 
pointer.  
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Chapter 5 
Speech 

MAGic Speaks 
Not only does MAGic magnify your computer’s screen, but it also has 
screen reading capabilities. You can customize MAGic’s speech 
components to fit your needs. The Speech menu, located on the menu 
bar contains all the controls to help you adapt MAGic’s speech to suit 
you.  

 

The first item on the Speech menu, Enable Speech, lets you activate or 
deactivate speech. If the menu item appears with a checkmark next to 
it, speech is enabled. If there is no checkmark, speech is disabled. 

The Speech Menu 

Voices 
From the Speech menu, choose Voices to set the basic components of 
how you hear MAGic. The Primary and Secondary Language tabs of the 
Voices dialog box contain the same controls.  
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Primary Language 

From the Primary Language tab of the Voices dialog box, you set your 
preferences for the language in which you want to hear MAGic. Choose 
from any of the languages available and proceed to set the 
specifications on this tab to fit your language choice. 

 

Secondary Language 

The secondary language is another language in which MAGic can speak. 
Press MAGic Key+F11 to switch to your secondary language. If you often 
use two languages, set your other language in the Secondary Language 
tab of the Voices dialog box. There you can also set your preferences for 
the voice of that other language. 
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Synthesizer 

By default MAGic uses Eloquence as its speech synthesizer, although if 
you have other Speech Application Interface (SAPI) synthesizers 
installed on your computer, you can use one of those synthesizers 
instead. When you first visit the Voices dialog box, the synthesizer list 
will only include Eloquence. Click the Update Synthesizer List button (or 
press ALT+U) to find the other compatible synthesizers installed on your 
system. While MAGic searches for other synthesizers you will see a 
message box indicating that it is looking for them.  

After MAGic locates all compatible synthesizers, you will see the Update 
Synthesizer List dialog box. On the left side of the dialog box, there is a 
list of the available SAPI Synthesizers. Along the middle of the dialog 
box, there is a series of buttons that will allow you to add or remove 
synthesizers.  
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To add a new synthesizer:  

1. Select one or more synthesizers from the Available SAPI 
Synthesizer list. 

2. Choose the Add button to add just the selected synthesizers to the 
Synthesizer List for MAGic, or choose Add All to move all 
synthesizers to the Synthesizer List for MAGic.  

To remove a synthesizer from the Synthesizer List for MAGic: 

1. Select one or more synthesizers from the Synthesizer List for 
MAGic. 

2. Choose the Remove button to remove only the selected 
synthesizers, or choose Remove All to remove all the synthesizers 
from the Synthesizer List for MAGic.   

Note: Although Eloquence does not appear in the Update 
Synthesizer list dialog box, it always appears in your 
synthesizer list in the Voices dialog box. Eloquence is always 
available for your use.  

Choose OK to accept these changes and move back to the Voices dialog 
box. Your updated synthesizer list will apply to both the Primary or 
Secondary Language tabs. From within the Voices dialog box, move to 
the either the Primary or Secondary Language tab and select your 
desired synthesizer from the Synthesizer list. This changes the 
synthesizer only for the active language tab. 
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Language 

When MAGic is initially installed, on the Primary Language tab, the 
language is set to the language in which your MAGic menus appear. On 
the Secondary Language tab, the language is set to None, until you 
change it. 

Speaker 

Next is your choice of speaker, which provides different voices, used for 
MAGic.  

Pitch 

Use this spin box to control the tone of the voice you select.  

Sample Voice 

Use this button to hear a preview of the voice and language settings you 
have specified. 

Speech Rates 

As you use MAGic, you may want to hear different types of activities at 
different rates. For instance, while you are typing, you may want MAGic 
to read more quickly, so that you can ensure the accuracy of your typing. 
On the other hand, if you are reading a document, you might want 
MAGic to speak more slowly, so you can concentrate on content.  

• Default - This is the speed at which MAGic will read most of the 
items that appear on your screen, including dialog boxes and 
menus.  

• Reading – This is the speech rate MAGic uses for reading 
documents, e-mail messages, or Web sites. 

• Typing Echo - MAGic repeats what you type. Use this spin box to 
specify how fast you want MAGic to echo your keystrokes back to 
you. 
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Mouse Echo 
If mouse echo is enabled, MAGic reads text that you point to with the 
mouse. To customize this feature, open the Speech menu and choose 
Mouse Echo.  

 

Enable Mouse Echo 

Use this check box to turn mouse echo on or off. 

Note: MAGic still speaks ToolTips if mouse echo is off. If you do not 
want MAGic to speak ToolTips, open the Speech menu and 
choose Verbosity. Then clear the Tool Tips check box. 

Speech Delay 

Specify the length of time you want MAGic to wait before it reads the 
word or line at the current location of the mouse pointer. The delay is 
measured in seconds. If you move the mouse pointer away before the 
delay has elapsed, MAGic does not read the word or line. 

Point & Speak 

In this area, select one of the following options: 

• Word at Mouse Position - MAGic reads the word at the current 
location of the mouse pointer. You must point at the word for the 
length of time specified in the Mouse Speech Delay box before 
MAGic reads the word. 
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• Line at Mouse Position - MAGic reads the line of text at the current 
location of the mouse pointer. You must point at the line for the 
length of time specified in the Mouse Speech Delay box before 
MAGic reads the line. 

Mouse Movement Stops Speech 

Select this check box to allow MAGic to interrupt speech when you move 
the mouse pointer over text. If you clear this check box, you can move 
the mouse pointer anywhere on the screen without interrupting speech. 
This option does not interrupt speech generated by mouse echo. 

Typing Echo 
As you type, MAGic announces what you have typed. To customize this 
feature, open the Speech menu and choose Typing Echo. 

 

Enable Typing Echo 

Check this box to turn typing echo on or off. 

Automatically Speak 

MAGic presents four choices for what is automatically spoken. 

• Arrow Keys Only – Speaks the letter to the right of the cursor as 
you press the arrow keys to move through the text. If you press 
the up or down arrow keys, MAGic will speak the line. Pressing 
CTRL+RIGHT or LEFT ARROW causes MAGic to read the word. 
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• Letter by Letter – Announces all alphanumeric characters and 
punctuation as they are typed, during word processing, editing, or 
data entry. 

• Word by Word – Speaks each word that you type after you press 
the SPACEBAR. 

• All Keystrokes – Announces every key that you press. 

Note:  When you are using Java-based programs, MAGic announces 
each key that you press regardless of which option you select. 

Keystrokes to Echo 

As you type MAGic speaks, but if your typing speed is faster than the 
time it takes for the speech to respond to the keyboard your speech will 
lag behind typing. If so, adjust the Keystrokes to Echo. 

• Last Entry Only – If speech output lags behind typing, then MAGic 
speaks only the most recent entry, and discards the backlog. 

• Last 10 Entries – MAGic speaks the last ten entries and discards 
the backlog when speech output lags behind typing.  

• Speak All Entries – Even if a backlog occurs, MAGic speaks all 
entries.  

Say “Cap” Before Uppercase Letters 

If you select this check box, MAGic says, “Cap,” before reading capital 
letters that you have typed or moved to with the arrow keys. You can 
enable or disable this option at any time by pressing MAGic Key+F2. 

Verbosity 
From the Speech menu, choose Verbosity to control the event driven 
functions that MAGic speaks. Select the check boxes of the items that 
you want to hear. 
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Automatically Speak 

Automatically Speak contains a group of check boxes for items that you 
can choose to hear or not.  

With these check boxes selected, the following is what you will hear: 

• Window Titles – MAGic speaks the text that appears on the title 
bar of the window as the window becomes active. 

• Menus & Highlights – As you navigate the menu items, MAGic 
speaks the highlighted menu items. 

• Buttons & Check Boxes – MAGic speaks buttons and check boxes 
as you select them. 

• Group Boxes – Group boxes are collections of related check boxes 
or radio buttons often boxed together in a group with a common 
category or group heading. For example, in the Verbosity dialog 
box, the group boxes are Automatically Speak and Speak 
Shortcuts. When checked, MAGic speaks the group box heading 
the first time you select a button in the group. 
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• Edit Boxes – An edit box is a field into which you type information. 
A list may appear beneath the field, from which you can make a 
selection, making this type of edit box a combo box. MAGic speaks 
edit boxes and combo boxes when they gain focus.  

• Tool Tips – ToolTips frequently appear when you rest the mouse 
over an item for a brief period of time. The ToolTip gives you a 
brief description of the item. MAGic speaks ToolTips of any length.  

• Questions – MAGic reads questions that may appear when dialog 
boxes are displayed. For example, “Are you sure you want to quit? 

• Explanations – MAGic reads explanatory text that may appear 
when dialog boxes are displayed. For example, “Type the name of 
the program, folder, or document and Windows will open it for 
you.” 

• Text Changes – MAGic speaks dialog box text updates that may 
reflect status changes. Such updates may include the number of 
installation minutes remaining, or changes to display resolution. 

• Unpunctuated Phrases - MAGic reads text that appears in dialog 
boxes that does not contain punctuation. 

Speak Shortcuts 

Within menus and buttons, often a letter is underlined. You can press 
the underlined letter (also called an access key) in conjunction with the 
ALT key to activate the command or button.   

Menu selections may also list a keyboard combination that you can use 
to activate that choice without the use of the mouse or the menus. For 
example, on the File menu, to the right of Save Settings, you’ll notice 
CTRL+S. You can press CTRL+S to carry out the Save Settings command 
without opening the menus. 

You can choose how MAGic reads underlined letters and shortcuts by 
selecting or clearing the following check boxes: 

• Button Underline – MAGic reads the underlined letter for buttons. 

• Menu Underline – MAGic reads the underlined letter for menus 
and menu commands. 



 

 81 

• Menu Shortcut – If a menu command has a shortcut key, MAGic 
reads the shortcut. 

Note: MAGic reads underlined letters before the button or menu or 
command name. 

Synchronization 
From the Speech menu, choose Synchronization to change how speech 
and large print are synchronized on the display. You can set 
synchronization differently for document and text reading and for dialog 
box reading.  

Document and Text Reading 

The Document and Text Reading tab allows you to choose how MAGic 
synchronizes speech and large print when reading documents and text. 

 

Visual Synchronization 

Select one of the following visual synchronization options: 

• Off - Speech is not synchronized with the text that appears on your 
screen. 

• Word by Word – MAGic shows the words on the screen as they are 
spoken.  
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• Line by Line – MAGic shows the lines on the screen as they are 
spoken. When synchronization is set to Line by Line, MAGic moves 
down each line, but it does not move left to right to show all words 
on the line. 

Tip:  To change how MAGic highlights text as it reads, open the 
Speech menu and choose Document and Text Reading. 

Auto Advance 

The following options automatically advance the mouse and typing 
cursor in synchronization with reading: 

• Mouse Pointer – If you select this check box, MAGic automatically 
advances the mouse pointer while reading. When reading stops, or 
you decide to pause, the mouse points to the last item that MAGic 
read. 

• Typing Cursor – If you select this check box, MAGic automatically 
advances the insertion point while reading. When reading stops, or 
you decide to pause, the insertion point is positioned over the last 
item that MAGic read. This feature is only active when reading 
documents and windows that you can edit. 

Dialog Box Reading 

The Dialog Box Reading tab allows you to choose how MAGic 
synchronizes speech and large print when reading dialog boxes. 
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Visual Synchronization 

Select one of the following visual synchronization options: 

• Off - Speech is not synchronized with the text that appears on your 
screen. 

• Word by Word – MAGic shows the words on the screen as they are 
spoken.  

• Line by Line – MAGic shows the lines on the screen as they are 
spoken. When synchronization is set to Line by Line, MAGic moves 
down each line, but it does not move left to right to show all words 
on the line. 

Inverted Highlight On 

Select this check box to show the text as white, and the highlight as a 
black square around it when text is read. 

Document and Text Reading 
From the Speech menu, choose Document and Text Reading to 
customize how MAGic reads, highlights text, and scrolls the page. 

Note:  You cannot use the box highlight style or adjust the 
transparency, thickness, or color of the highlighting if you are 
using Windows 95, 98, or ME.  
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Highlight Style 

When MAGic uses synthesized speech to read the text on your screen, it 
can highlight the text it is speaking. This allows you to easily follow the 
text visually while MAGic reads. In the Highlight Style list, choose one 
of the following options to specify how you want MAGic to highlight text: 

• None – MAGic does not highlight text as it reads. 

• Box – Surrounds the text MAGic reads with an empty, rectangular 
outline. 

• Block – Highlights the text MAGic reads with a solid rectangle.  

• Underline – Underlines the text that MAGic reads. 

Color 

In the Color list, choose a color for the highlight style you selected. If 
you want to invert the colors in the area covered by the highlight, 
choose Invert Colors.  

Transparency 

Use the Transparency slider to adjust the transparency level of the 
selected highlight style. A higher level of transparency allows you to see 
more of the surrounding area covered by the highlighting. 
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Thickness 

Use the Thickness slider to adjust the thickness of the highlight style 
you selected. This lets you change the vertical size of the underline and 
block highlight styles, and determine the thickness of the border for the 
box highlight style. 

Auto Scroll During Reading 

The Auto Scroll During Reading area lets you customize how speech 
advances when the bottom of a window is reached. 

• None – Reading stops at the bottom of the window regardless of 
the size of the document. The document does not scroll 
automatically; you must move to the next screen manually and 
make MAGic begin speaking again. 

• By Page – Reading continues beyond the window limit by 
automatically feeding the next page of the document. 

• By Line – Reading continues beyond the window limit by 
automatically feeding the document one line at a time.  

Speak Text Block As 

Use the Speak Text Block As area to determine whether you want MAGic 
to read by word or character. 

• Words – MAGic reads each word in the text block. 

• Characters – MAGic reads each character in text block, allowing 
you to hear how the words are spelled. 

Auto Speak Web Pages 

Select the Auto Speak Web Pages check box if you want MAGic to 
automatically begin reading when you view Web pages or other HTML 
documents.  
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Chapter 6 
Keyboard 

The Keyboard menu allows you to customize how you use your 
computer’s keyboard with MAGic.  

 

MAGic Key 
Pressing the MAGic Key in combination with other keys activates a 
MAGic command if one is assigned, otherwise it will pass the key 
combination through to the application. Pressing the MAGic Key by itself 
and releasing it will not carry out any action.  

The default MAGic Key is CAPS LOCK. From the Keyboard menu, choose 
MAGic Key to assign the MAGic Key to any of the following keys:  
extended INSERT (found on the six pack), NUM PAD INSERT, either 
INSERT, or SCROLL LOCK (the key just above HOME on the six pack). 
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Keyboard Assignments 
From the Keyboard menu on the MAGic user interface, select Keyboard 
Assignments to learn more about the hot keys in MAGic. You can view 
the current hot keys assigned to actions, assign different hot keys, 
remove hot keys, or restore the hot keys to the default settings from 
within the Keyboard Assignments dialog box.  

 

In the Category list, select what kind of hot keys you want to view. By 
choosing one of these categories, the items in the Action list will change 
to show only items that fit the category, making the list more 
manageable.  

Note: Selecting a specific application category shows hot keys for 
special MAGic functions in that application. Selecting All 
Default will not show application hot keys. 

Move to the Action list and select the action that you want to view. The 
hot key appears in the Current Hot Keys list, located to the right. If no 
hot key appears in the Current Hot Keys list, no hot key is assigned.  
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Customizing Hot Keys 
To add a hot key, select an action in the Action list and click Assign Hot 
Key or press ALT+S. Press the combination of keys that you want to 
assign to the selected action. The key combination appears in the 
Assign To edit box.  

When you assign hot keys to actions, it doesn’t matter whether you 
press the right or left ALT, CTRL, or SHIFT key. However, you may want 
to use only the left or right key so that additional key combinations 
remain available. To specify the left or right ALT, CTRL, or SHIFT keys for 
a hot key, select the appropriate check box(es) in the Differentiate 
Between area before you activate the Assign Hot Key button. For 
example, if you want to create a hot key that uses only the left ALT key, 
select the Left/Right Alt check box. 

Note:  The hot keys that you assign while these check boxes are 
selected will always require you to press the correct left or 
right key. If you later clear the check box, previously created 
hot keys still require you to use the correct left or right key.  

To remove a hot key, select it in the Current Hot Keys list and click 
Remove Hot Key or press ALT+R. MAGic then asks you to confirm that 
you want to delete the hot key.  

You can click Restore Defaults or press ALT+D to return all hot key 
assignments to their original key combinations.   
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Chapter 7 
Application Specific Functions 

MAGic contains application specific functions to help you work in 
popular software applications. With MAGic’s application specific 
functions, you will find that using these functions consolidates screen 
information, enhances application navigation, and eliminates visual 
clutter. 

For example, with MAGic running in Microsoft® Excel you can bring up a 
dialog box that will list the cells for a particular row that contain data. 
This consolidates screen information, because it presents the header, if 
one exists, and only those cells containing data. You can then move 
directly to a particular cell, without pressing the arrow keys to move 
through multiple empty cells, which enhances application navigation. 
When using MAGic with Microsoft® Internet Explorer, you can eliminate 
visual clutter by reformatting the screen. After you reformat, MAGic 
presents only the necessary text, and hides graphics that may not be of 
interest to you. With only the text showing, you’ll find it easier to read 
the less cluttered screen. 

MAGic has included Application Specific Functions for Microsoft® Word, 
Microsoft® Excel, and Microsoft® Internet Explorer. 

MAGic and Microsoft Word 
MAGic has shortcut keys to help you use Microsoft Word 97, 2000, and 
2002 without relying on the mouse to access certain features.  

List Spelling Errors  CTRL+SHIFT+E 

List Revisions  CTRL+SHIFT+V 

List Grammatical Errors  CTRL+SHIFT+G 

List Comments  CTRL+SHIFT+APOSTROPHE 

Post Comment  ALT+SHIFT+APOSTROPHE 



 

90 

List Hyperlinks  MAGic KEY+F8 

List Inline Objects  CTRL+SHIFT+O 

Focus to First Form Field  MAGic KEY+CTRL+HOME 

Select a Field  CTRL+SHIFT+L 

Select a Table  MAGic KEY+CTRL+T 

Post Footnote or Endnote  ALT+SHIFT+E 

Listed below are detailed descriptions of the MAGic keystrokes you can 
use in Microsoft Word. 

List Spelling Errors 
Press CTRL+SHIFT+E to list all the words Microsoft Word marked as 
misspelled. From this dialog box, you can move to a selected misspelled 
word in the document. 

List Revisions 
Press CTRL+SHIFT+V to list all the revisions in Word’s Track Changes 
feature. From this dialog box, you can move to a selected revision in the 
document. 

List Grammatical Errors 
Use CTRL+SHIFT+G to list all the phrases marked by Microsoft Word as 
grammatical errors. From this dialog box, you can move to a selected 
grammatical error in the document. 

List Comments 
Use CTRL+SHIFT+APOSTROPHE to list all the reviewer’s comments 
throughout the document, and this dialog box allows you to move to the 
selected comment. 
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Post Comment 
Press ALT+SHIFT+ APOSTROPHE to display a comment in a message 
box. To use this keystroke you must enable “Unpunctuated Phrases” in 
the Verbosity dialog box found under the Speech menu and place the 
insertion point at the very end of the comment marker in the document. 
Use this keystroke to avoid hovering over the comment marker in the 
document. If you hover over the comment marker in higher 
magnifications, scrolling the magnified comment text could be a 
problem. 

List Hyperlinks 
Press MAGic Key+F8 to list the hyperlinks in the current document. 
From this dialog box, you can either move to the hyperlink in the 
document, or you can activate the hyperlink.  

List Inline Objects 
Press CTRL+SHIFT+O to list all the objects in the text layer of the 
document. It allows you to move to the location of the selected object in 
the document.   

Focus to First Form Field 
Press MAGic Key+CTRL+HOME to move to the first form field in a 
document. 

Select a Field 
Use CTRL+SHIFT+L to list all the fields in a document. From this dialog 
box, you can move to a selected field. 

Select a Table 
Press MAGic Key+CTRL+T to list all the tables in the document. You can 
move to a table from the dialog box that appears. If the document is 
protected to only allow edits in form fields, MAGic moves the insertion 
point to the first form field of the selected table. 

Post Footnote or Endnote 
Press ALT+SHIFT+E to display a footnote or endnote in a message box. 
The insertion point must be located on the footnote or endnote 
reference and you must enable “Unpunctuated Phrases” in the Verbosity 
dialog box found under MAGic’s Speech menu.   
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MAGic and Microsoft Excel 
MAGic has shortcut keys to help you use Microsoft Excel 97, 2000, or 
2002 without relying on the mouse to access certain features.  

Adjust MAGic Options  MAGic Key+O 

List Cells with Comments  CTRL+SHIFT+APOSTROPHE 

List Column  CTRL+SHIFT+C 

Post Column Title  ALT+SHIFT+C 

Post Column Total  MAGic KEY+ENTER 

List Row  CTRL+SHIFT+R 

Post Row Title  ALT+SHIFT+R 

Post Row Total  MAGic KEY+R 

List Visible Cells with Data  CTRL+SHIFT+D 

Select Hyperlink  CTRL+SHIFT+H 

Set Monitor Cells  ALT+CTRL+SHIFT+1 THROUGH 0 

Move to Monitor Cell  CTRL+SHIFT+M 

Post Monitor Cells  ALT+SHIFT+1 THROUGH 0 

Listed below are detailed descriptions of the MAGic keystrokes you can 
use in Excel. 

Adjust MAGic Options 
Press MAGic Key+O to adjust options that allow for easier navigation in 
higher levels of magnification. MAGic presents the Adjust MAGic 
Options dialog box, which contains several options from which you can 
choose. 
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• Single or multiple region support –If you use more than one 
region in Excel, turn on multiple region support to hear when you 
enter different regions. For information regarding regions, please 
see the Excel Help file. 

• Set region column titles to row range – MAGic defined the selected 
row range as the rows containing column titles so that when you 
press the keystroke to Post Column Title, MAGic reads the title for 
the current row. 

• Set region row titles to column range – MAGic define the selected 
column range as the columns containing row titles so that when 
you press the keystroke to Post Row Title, MAGic reads the title for 
the current column.  

• Set region total column to current – MAGic defines as the column 
in this region where row totals will be found. If you press post row 
total, instead of searching down the row to find the total, MAGic 
looks directly to this column. 

• Set region total row to current – MAGic defines as the row in this 
region where column totals will be found. If you press post column 
total, instead of searching down the column to find the total, 
MAGic looks directly to this column. 

• Set next available monitor cell – A monitor cell is a cell or range of 
cells you can observe while you work in other areas of the 
spreadsheet. You have ten monitor cells available, which are 
defined by pressing ALT+CTRL+SHIFT+1 through 0 on the number 
row, and read by pressing ALT+SHIFT+1 through 0. Instead of 
using ALT+CTRL+SHIFT+1 through 0, you can press MAGic Key+O 
for Adjust MAGic Options, and press the SPACEBAR on this option, 
and MAGic determines the next undefined monitor cell for this 
sheet and defines it to point to the currently selected range of 
cells. MAGic then tells you which monitor cell it has assigned to 
the range. Then you press the appropriate keystroke to read this 
range from anywhere on this sheet. For example, if you hear, 
“assigning monitor cell 5 to B5, it means that you should press 
ALT+SHIFT+5 to hear the cell contents. Monitor cells are defined 
on a sheet-by-sheet basis regardless of the multiple or single 
region support setting. 
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• Clear worksheet’s monitor cells – Clears the monitor cells defined 
for the current sheet. 

• Clear region’s title/total definitions – Clears any definitions for the 
following:  the row range used for this region’s column titles, the 
column range used for this region’s row titles, and the row and 
column used for column and row totals. It also turns off title 
reading and resets MAGic so if you press a total reading keystroke 
(Post Row/Column total), MAGic will search across the row or 
down the column in the current region for a total rather than using 
the defined total row or column. 

List Cells with Comments 
Use CTRL+SHIFT+APOSTROPHE to list all of the cells in the visible 
window that have an attached comment. This allows you to quickly 
locate any visible cells that may provide important information about 
the spreadsheet. 

List Column 
Use CTRL+SHIFT+C to list the cells in the current column that contain 
data. From this dialog box, you can move to a particular cell. If you 
defined column or row titles they will also be displayed. 

Post Column Title 
Use ALT+SHIFT+C to display the current column’s title in a message 
box. Use this keystroke when you work in complex datasheets to find 
the column title without scrolling away from your current place. You 
must define the column’s title before the keystroke will be effective. Do 
so from within the Adjust MAGic Options dialog box. You also must 
enable “Unpunctuated Phrases” in the Verbosity dialog box found under 
MAGic’s Speech menu. 

Post Column Total 
Press MAGic Key+ENTER to display the current column’s total in a 
message box. Magic will find either the predefined row containing 
column totals, set in the Adjust MAGic Options dialog box, or will search 
the current column for a cell that contains the word SUM. You also must 
enable “Unpunctuated Phrases” in the Verbosity dialog box found under 
MAGic’s Speech menu. 
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List Row 
Use CTRL+SHIFT+R to list the cells in the current row that contain data. 
This allows you to set focus on the selected cell. If you defined column 
or row titles they will also be displayed. 

Post Row Title 
Press ALT+SHIFT+R to display the current row’s title in a message box. 
You must define the row’s title first, using the Adjust MAGic Options 
dialog box and you must enable “Unpunctuated Phrases” in the 
Verbosity dialog box found under the Speech menu. 

Post Row Total 
Use MAGic Key+DELETE to display the current row’s total in a message 
box. MAGic will find either the predefined column containing row totals, 
set in the Adjust MAGic Options dialog box, or will search the current 
row for a cell that contains the word SUM. To use this keystroke you 
must enable “Unpunctuated Phrases” in the Verbosity dialog box found 
under the Speech menu. 

List Visible Cells with Data 
Use CTRL+SHIFT+D to list only the cells with data, which are visible on 
the screen. This enables you to quickly access relevant cells that are 
visible on the current screen, skipping blank cells. 

Select Hyperlink 
Press CTRL+SHIFT+H to list all hyperlinks on the current sheet, and this 
dialog box allows you to either move to the cell containing the 
hyperlink, or activate the link. 

Set Monitor Cells 
Use monitor cells to observe an area of your spreadsheet as you work. 
Press ALT+CTRL+SHIFT+1 to assign the cell or region of cells to the first 
monitor cell. Use ALT+CTRL+SHIFT+1 through 0 on the number row to 
assign up to ten different monitor cells. 

Move to Monitor Cell 
Press CTRL+SHIFT+M to list all defined monitor cells, so you can move 
to a particular cell. 
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Post Monitor Cells 
Use the keystroke ALT+SHIFT+1 through 0 on the number row to 
display the contents of that monitor cell in a message box. For example 
if you have 5 monitor cells defined, and you want to know the 
information in the 3rd monitor cell, press ALT+SHIFT+3. To use this 
keystroke you must enable “Unpunctuated Phrases” in the Verbosity 
dialog box found under the Speech menu. 

MAGic and Microsoft Internet Explorer 
MAGic has shortcut keys to help you use Microsoft Internet Explorer 
5.01 and later without relying on the mouse to access certain features.  

Reformat Document  MAGic Key+F5 

Select a Link  MAGic Key+F7 

Listed below are detailed descriptions of the MAGic keystrokes you can 
use in Internet Explorer. 

Reformat Document 
Use MAGic Key+F5 to reformat multiple column pages to be more 
readable with speech. Reformat Document rearranges multiple column 
pages to read in a linear fashion. Internet Explorer columns are read 
one after another. To restore the page to its original appearance, press 
F5. 

Select a Link 
Use MAGic Key+F7 to bring up a dialog box containing a list of the links 
present in the page. You can then select a link by using the arrow keys 
or the first letter of the link. Press ENTER to open the selected link. You 
may also press the TAB key to move between the various controls in the 
Select a Link dialog box. 
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Chapter 8 
Contacting Freedom Scientific 

 

Corporate Headquarters 

Freedom Scientific BLV Group, LLC 
11800 31st Court North 
St. Petersburg, FL 33716-1805 
USA 

Telephone: (727) 803-8000 

Fax: (727) 803-8001 

World Wide Web: http://www.FreedomScientific.com  

Office hours: Monday through Friday 8:30 am to 5:00 pm Eastern 
Standard Time (USA) 

Technical Support Hours:  Monday through Friday 8:30 am to 7:00 pm 
Eastern Standard Time (USA) 

Freedom Scientific Web Site 
The Freedom Scientific Web site, http://www.FreedomScientific.com, is a 
comprehensive source of information regarding MAGic screen 
magnification software, JAWS screen reader software, training 
opportunities, application-specific cassette tutorials and the company 
that develops these products.  
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The Freedom Scientific Web site is designed to be accessible by people 
with disabilities and includes a great deal of technical support 
information as well as online ordering capability, RealAudio descriptions 
of many products, and continuous product update and maintenance 
downloads. 

Documentation Feedback 
At Freedom Scientific, we strive to produce the highest quality 
documentation products, and welcome your feedback. If you have 
comments or suggestions about our online Help or printed guides, send 
your e-mail messages to Documentation@FreedomScientific.com. 

Sales 
Contacting the Freedom Scientific Sales Department 

Sales Telephone: (800) 444-4443 

International Sales Telephone, including Canada: (727) 803-8000 

Sales Fax: (727) 803-8001 

World Wide Web:  http://www.FreedomScientific.com  

Sales e-mail:  info@FreedomScientific.com 

To ensure that your request is handled promptly, include your complete 
address and telephone number. 

Office Hours: Monday through Friday,  
8:30 am to 5:00 pm EST (USA) 

Technical Support 
You must be a registered user to access Freedom Scientific support 
services. Freedom Scientific support services are subject to Freedom 
Scientific terms and conditions in place at the time the service is used.  

Reach Technical Support using the following options: 

World Wide Web: http://www.FreedomScientific.com  
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Technical Support e-mail: Support@FreedomScientific.com 

Technical Support Telephone: (727) 803-8600  

When you call, be at your computer, have your documentation in hand, 
and be prepared to provide the following information: 

• Product serial number used for registration. 

• Product name and version number. 

• Type of computer hardware you are using. 

• Software version number of Windows. 

• Exact wording of any messages that appear on your screen. 

• What you were doing when the problem occurred. 

• How you tried to solve the problem. 

Technical Support Hours:   Monday through Friday  
8:30 am to 7:00 pm EST (USA) 
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Appendix A 
SAPI Synthesizers on a Network 

When you use MAGic on a network, the procedure for selecting a 
synthesizer other than Eloquence is the same as when you use a 
standalone version of MAGic.  

When you update your synthesizer list in the Voices dialog box, the 
synthesizers that populate the Available SAPI Synthesizers list are 
stored in your user profile. Therefore, the next time that you log into 
MAGic this information will automatically be displayed for you.  

If you move to another computer that does not have the same 
synthesizers installed, and attempt to change your synthesizer to one of 
these, you will receive a message stating, “The synthesizer you have 
selected is not available. Would you like this synthesizer removed from 
your list of available synthesizers.” Choose Yes if you do not want to use 
this synthesizer on the network in the future. Choose No to have the 
synthesizer remain in your list for use on other network computers. 
When you choose an unavailable synthesizer, after attempting to find 
the synthesizer on your computer, MAGic will continue to use the 
synthesizer you were using before attempting to change synthesizers. If 
you select a synthesizer other than Eloquence as your synthesizer for 
your primary language, and move to a computer that does not have that 
synthesizer installed, when you log into MAGic, you will receive 
notification of this. Speech then defaults to Eloquence.  

If you select a synthesizer other than Eloquence as your synthesizer for 
your secondary language, and move to a computer that does not have 
that synthesizer installed, when you press MAGic Key+F11 to toggle the 
language, you will receive notification of this. MAGic then uses the same 
synthesizer that you have set for your primary language. 
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Appendix B 
Hot Keys 

General 
Start MAGic ALT+CTRL+M 

Minimize/Restore the MAGic User 
Interface 

MAGic Key+U 

Pass Through Key MAGic Key+3 

Refresh Screen MAGic Key+ESC 

Magnification, Views, & Enhancements 

Increase Magnification  
MAGic Key+NUM PAD PLUS or 
CTRL+EQUALS 

Decrease Magnification 
MAGic Key+NUM PAD MINUS or 
CTRL+DASH 

Magnification Toggle On/Off MAGic Key+DELETE 

Toggle between 1x Magnification  MAGic Key+DELETE+SHIFT 

Switch between Magnified Views MAGic Key+NUM PAD SLASH 

Toggle Color Enhancements On/Off MAGic Key+F12 

Toggle Cursor Enhancements On/Off MAGic Key+F8 

Toggle Mouse Enhancements On/Off MAGic Key+F4 

Panning and Screen Movement 
Pan Right MAGic Key+RIGHT ARROW 
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Pan Left MAGic Key+LEFT ARROW 

Pan Down MAGic Key+DOWN ARROW 

Pan Up MAGic Key+UP ARROW 

Increase Speed during Panning NUM PAD PLUS  

Decrease Speed during Panning NUM PAD MINUS 

Move to Left Edge of Screen in 
Magnified View MAGic Key+HOME 

Move to Right Edge of Screen in 
Magnified View MAGic Key+END 

Move to top of Screen MAGic Key+PAGE UP 

Move to Bottom of Screen MAGic Key+PAGE DOWN 

Move to Beginning of Next Line MAGic Key+ENTER 

Tracking 
Tracking Toggle On/Off  MAGic Key+R 

Reposition Mouse MAGic Key+NUM PAD 5 

Locator Mode 
Start Locator MAGic Key+F10 

Stop Locator and Move to Selected 
Area 

ENTER 

Stop Locator without Moving the 
Magnified Area 

ESC 

Move Left LEFT ARROW 



 

 103 

Move Right RIGHT ARROW 

Move Up UP ARROW 

Move Down DOWN ARROW 

Move to End of Line END 

Move to Beginning of Line HOME 

Move to Top of Screen PAGE UP 

Move to Bottom of Screen PAGE DOWN 

Quick View Frame 
Toggle Quick View Frame On/Off  MAGic Key+Q 

Set upper left corner of frame MAGic Key+LEFT BRACKET 

Set lower right corner of frame MAGic Key+RIGHT BRACKET 

Create frame around current dialog 
box option 

MAGic Key+LEFT BRACKET twice 
quickly 

Open Quick View Manager MAGic Key+9 

Speech 
Silence Current Speech CTRL 

Enable/Disable Speech MAGic Key+F3 

Toggle between Primary and 
Secondary Language MAGic Key+F11 
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Note: On multi-language systems, the primary language by default is the 
language of the operating system. When you choose a second 
language, use MAGic Key+F11 to toggle between the primary and 
secondary language. To set another language, do so in the Voices 
dialog box, activated from the Speech menu on the MAGic user 
interface.  

Document Reading 

Read All from Location 
MAGic Key+SPACEBAR or 
INSERT+DOWN ARROW 

Read Active Window (reads from the 
beginning of document window)  

MAGic Key+SPACEBAR (twice) or 
INSERT+DOWN ARROW (twice) 

Say Title Bar MAGic Key+T or INSERT+END 

Read Column from Current Position MAGic Key+C 

Read Bottom of Window INSERT+PAGE DOWN 

Text Reading 
Say Current Color Block MAGic Key+CTRL 

Say Current Word 
MAGic Key+ALT or INSERT+NUM PAD 
5 

Spell Current Word 
MAGic Key+ALT (twice) or 
INSERT+NUM PAD 5 (twice) 

Say Next Word INSERT+RIGHT ARROW 

Say Prior Word INSERT+LEFT ARROW 

Say Current Line MAGic Key+L or INSERT+UP ARROW 

Read to Cursor INSERT+HOME 

Read from Cursor INSERT+PAGE UP 

Say Current Sentence MAGic Key+S 
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Say Next Sentence MAGic Key+SHIFT+S 

Say Current Paragraph MAGic Key+P 

Say Contents of Clipboard MAGic Key+X 

Note: When using the document and text reading commands, if you move 
the mouse MAGic reads from the current location of the mouse 
pointer. If you move the insertion point, MAGic reads from the 
location of the insertion point. 

Typing Echo 
Toggle announcement of uppercase 
letters on/off  MAGic Key+F2 

Mouse Echo 
Mouse Echo Toggle MAGic Key+M 

Note: Toggling the mouse echo rotates between speak lines, speak words, 
and mouse echo off. 

Some actions in MAGic do not have hot keys assigned. You can define hot 
keys for these features from within the Keyboard Assignments dialog box. 
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Appendix C 
Windows Shortcut Keys 

General 
Get Help F1 

Open the Start menu WINDOWS Key or CTRL+ESC 

Open Windows Explorer WINDOWS Key+E 

Open the Run dialog box WINDOWS Key+R 

Find file or folder from Desktop F3 

Minimize all windows WINDOWS Key+M 

Switch between programs ALT+TAB 

Quit the active program ALT+F4 

For Windows and Menus 
Open the application control menu ALT+SPACEBAR 

Move to the menu bar ALT 

Choose a menu command ENTER 

Move between menus ALT, arrow keys 

Close a menu ESC 

Close a cascading menu ALT 

Open a child window control menu ALT+HYPHEN 

Close a child window CTRL+F4 

Open the context menu APPLICATION Key or SHIFT+F10 
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For Dialog Boxes 
Move through dialog box options TAB 

Move backward through dialog box 
options SHIFT+TAB 

Move to another tab CTRL+TAB 

Reverse direction through tabs CTRL+SHIFT+TAB 

Move to first option HOME 

Move to last option END 

Select or clear an item in a list SPACEBAR or CTRL+SPACEBAR 

Select or clear a check box SPACEBAR 

For Reading Text 
Move left one character LEFT ARROW 

Move right one character RIGHT ARROW 

Move left one word  CTRL+LEFT ARROW 

Move right one word  CTRL+RIGHT ARROW 

Move to beginning of line HOME 

Move to end of line END 

Move up one paragraph CTRL+UP ARROW 

Move down one paragraph CTRL+DOWN ARROW 

Scroll up one screen PAGE UP 

Scroll down one screen PAGE DOWN 

Move to beginning of document CTRL+HOME 

Move to end of document CTRL+END 



 

108 

For Editing Text 
Copy CTRL+C 

Cut CTRL+X 

Paste CTRL+V 

Undo CTRL+Z 

Delete character to the left BACKSPACE 

Delete character to the right DELETE 

Select one character left SHIFT+LEFT ARROW 

Select one character right SHIFT+RIGHT ARROW 

Select one word left CTRL+SHIFT+LEFT ARROW 

Select one word right CTRL+SHIFT+RIGHT ARROW 

Select to beginning of line SHIFT+HOME 

Select to end of line SHIFT+END 

Select to beginning of document CTRL+SHIFT+HOME 

Select to end of document CTRL+SHIFT+END 

Select all CTRL+A 

For Windows Explorer 
Rename selected file or folder F2 

Open properties ALT+ENTER 

Refresh a window F5 

Switch between panes F6 or TAB 

Go up a level BACKSPACE 
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keystrokes to echo....................... 78 
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languages ......24, 72, 75, 100, 104 
length ....................................47, 52 
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line............................................... 51 
line delay ..................................... 67 
line lock ....................................... 70 
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Locator ............................ 18, 38, 64 

border...................................... 65 
button...................................... 38 
hot keys.................................102 
style ........................................ 64 

M 

M button ...................................... 33 
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magnification............................... 33 
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display..................................... 42 
enabling and disabling............ 33 
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level ........................... 17, 34, 43 
level button............................. 34 
level one.................................. 43 
Locator..................................... 64 
menu .................................19, 41 
panning ................................... 65 
smoothing ............................... 44 
tracking ................................... 68 
vertical stretch ........................ 43 
view properties........................ 57 

Magnification button .............17, 33 

magnified area ............... 44, 50, 53 
magnified views ....................18, 34 
menu bar ...............................19, 32 
menu tracking ............................. 69 
minimizing MAGic on startup ...... 23 
monochrome................................ 55 
mouse....................................28, 30 
mouse echo ..............21, 39, 40, 76 

button ..................................... 18 
hot keys ................................ 105 
speech delay ........................... 76 

mouse enhancements ................. 44 
attributes ................................ 45 
button ...............................17, 35 
colors ................................45, 46 
display..................................... 46 
pointer attributes.................... 45 
schemes .................................. 44 
size....................................45, 47 
styles....................................... 45 
transparency ........................... 45 

mouse tracking............................ 68 
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navigating MAGic......................... 28 
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opening MAGic............................. 15 
oval........................................46, 51 
overlay view...........................42, 59 
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panning..................................58, 65 
changing direction .................. 66 
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line delay................................. 67 
line wrap ................................. 67 
point size................................. 67 
quick advance.......................... 66 
speed.................................66, 67 
stopping .................................. 65 

pass through................................ 29 
passing the MAGic Key through... 28 
pitch............................................. 75 
point size ...............................58, 67 
preferences............................22, 32 
program group............................. 13 

Q 

Quick Access Window .................. 33 
Quick Start Guide........................... 2 
Quick View Frame ........................ 61 
quitting MAGic .......................15, 32 
QVF .............................................. 61 

R 

reading .............. 20, 21, 81, 82, 83 
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Resize View button ................18, 37 
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